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Preface

Welcome to the JD Edwards EnterpriseOne HTML Server on WebSphere Reference for IBM i on Power Systems Guide.


Audience

This guide is intended for system administrators and technical consultants who are responsible for installing and configuring JD Edwards EnterpriseOne.





Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.


Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.





Related Documents

You can access related documents from the JD Edwards EnterpriseOne Release Documentation Overview pages on My Oracle Support. Access the main documentation overview page by searching for the document ID, which is 876932.1, or by using this link:

https://support.oracle.com/CSP/main/article?cmd=show&type=NOT&id=876932.1

To navigate to this page from the My Oracle Support home page, click the Knowledge tab, and then click the Tools and Training menu, JD Edwards EnterpriseOne, Welcome Center, Release Information Overview.

This guide contains references to server configuration settings that JD Edwards EnterpriseOne stores in configuration files (such as jde.ini, jas.ini, jdbj.ini, jdelog.properties, and so on). Beginning with the JD Edwards EnterpriseOne Tools Release 8.97, it is highly recommended that you only access and manage these settings for the supported server types using the Server Manager program. See the JD Edwards EnterpriseOne Server Manager Guide.





Conventions

The following text conventions are used in this document:


	Convention	Meaning
	boldface	Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.
	italic	Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.
	monospace	Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.












1 Accessing Certifications (formerly Minimum Technical Requirements)

Customers must conform to the supported platforms for the release as detailed in the Certifications for JD Edwards EnterpriseOne. In addition, JD Edwards EnterpriseOne may integrate, interface, or work in conjunction with other Oracle products. Refer to the following link for cross-reference material in the Program Documentation for Program prerequisites and version cross-reference documents to assure compatibility of various Oracle products.

http://www.oracle.com/corporate/contracts/index.html

Access the Certifications from My Oracle Support (https://support.oracle.com) by searching for this product from the Certifications tab:

	
JD Edwards EnterpriseOne HTML Server









2 Understanding Server Manager and This Guide

Beginning with JD Edwards EnterpriseOne Tools Release 8.97, a new tool called Server Manager is provided. This tool is a complete replacement for the JD Edwards EnterpriseOne legacy management and installation tools including internal components known as Server Administration Workbench (SAW), Server Management Console (SMC), and the InstallShield based installers previously used to install or upgrade JD Edwards EnterpriseOne servers. As a result, you should refer to the JD Edwards EnterpriseOne Server Manager Guide for details on installing and configuring all JD Edwards EnterpriseOne server products, with the exception of the JD Edwards EnterpriseOne Deployment Server, whose installation is described in this guide. This guide only contains reference information for functionality outside the Server Manager tool.




	
Note:

Management of JD Edwards EnterpriseOne Tools Release 8.96 or earlier must be done using the existing tools. Server Manager cannot be used to manage any JD Edwards EnterpriseOne Tools Release prior to 8.97.







The Server Manager tool provides:

	
Web Based System Management

You can securely access and manage your JD Edwards EnterpriseOne installation from anywhere using a standard web browser.


	
Remote Deployment and Upgrades

You can install, uninstall, and update your JD Edwards EnterpriseOne servers regardless of their physical location or platform.


	
Remote Operational Control

You can start and stop any of your JD Edwards EnterpriseOne servers, Oracle J2EE application servers, or supported third party J2EE application servers directly from the Management Console.


	
Secure Administrative Tasks

Server Manager permits you to specify which existing JD Edwards EnterpriseOne users have access to the Management Console control which JD Edwards EnterpriseOne servers the user may view, and specify which administrative tasks the user may perform on those servers.


	
Configuration Management

Server Manager provides a web-based interface for managing the configuration of all managed servers. The application presents each configuration item along with integrated help describing the configuration setting.




	
Note:

Beginning with the availability of Server Manager, it is strongly advised that all changes to configuration files (such as jde.ini, jas.ini, jdbj.ini, jdelog.properties, etc.) for any JD Edwards EnterpriseOne server managed by Server Manager be accomplished using only the Management Console interface of Server Manager. In addition to providing usability improvements, using Server Manager reduces the risk of introducing configuration errors by providing dropdowns that contain only valid values where applicable. Further, the tool provides a useful audit history for any modifications made to configurations using Server Manager.








	
Configuration Comparison

Use Server Manager to compare the configuration of two or more servers to identify configuration differences. You can compare configurations through the Management Console application regardless of the platform or location of the actual JD Edwards EnterpriseOne server. You can also compare individual servers with the default configuration of the corresponding server groups to which the servers belong.


	
Audit History

Server Manager maintains a history of changes made to the managed servers. This includes a history of each configuration change, each server start and stop, and each tools release update, including the user that performed the change or operation. The Management Console application provides mechanisms to query and view the audit history that is maintained.


	
Integrated EnterpriseOne Software Management

Use Server Manager to centrally maintain all your JD Edwards EnterpriseOne server tools releases, including the ability to copy the software to the remote server machines.


	
Logical Server Grouping

Server Manager allows you to group servers with a similar purpose. These groups can include any of the server types such as Enterprise Server, HTML Server, and so on. A default, or template, configuration is maintained for each server group.


	
Application Release Independence

Server Manager is delivered with JD Edwards EnterpriseOne Tools Release 8.97 and is compatible with any supported JD Edwards EnterpriseOne application release beginning with Application Release 8.9 through the currently supported release. No electronic software updates (ESUs) are required to support Server Manager.


	
Self-Contained Installation

The installation of Server Manager delivers all components that are required by the Management Console application. There are no third party requirements regardless of your existing or intended middleware topology (for example, WebLogic Server, Oracle Application Server, WebSphere Application Server, or no application server).


	
Tools Release Independence

Newer versions of the Server Manager application will continue to support the management of earlier tools releases back to JD Edwards EnterpriseOne Tools Release 8.97.









3 Installing and Configuring WebSphere 8.5 and 8.5.5

Beginning with JD Edwards EnterpriseOne Tools Release 9.1 Update 2.3, the IBM WebSphere Application Server Release 8.5 is supported.

Beginning with JD Edwards EnterpriseOne Tools Release 9.1 Update 3.3, the IBM WebSphere Application Server Release 8.5.5 is supported. This fix pack can be installed as a new installation or an update.

Relative to WebSphere 7.0, with IBM WebSphere 8.5 the installation procedure has changed dramatically. You will now use the IBM Installation Manager as a central hub to manage the installation process. The IBM Installation Manager is designed to make the installation procedure much simpler and easier than in prior releases.

Additionally IBM WebSphere Application Server 8.5 supports SDK 1.6 as the basic configuration but with SDK 1.7 as an optional configuration.For JD Edwards EnterpriseOne, the implementation requires SDK 1.7 as the default run-time configuration for WebSphere Application Server 8.5. Therefore, after WebSphere Application Server is installed with the basic configuration, you MUST change the default SDK to 1.7.

There are several different methods that you can install WebSphere Application Server 8.5 on IBM i operating system:

	
Response files


	
Command line


	
iRemoteInstall Command




This document focuses on both the Command Line and iRemoteInstall Command methods.

This chapter describes these tasks:

	
Section 3.1, "Before You Begin"


	
Section 3.2, "Installing WebSphere Products using Command Line"


	
Section 3.3, "Installing WebSphere Products using iRemoteInstall Command"


	
Section 3.4, "Installing and Configuring the IBM HTTP server"


	
Section 3.5, "Applying Updates to the WebSphere Application Server 8.5"


	
Section 3.6, "Verifying SDK 7.0 on WebSphere Application Server 8.5"


	
Section 3.7, "Switching to SDK 7.0 on WebSphere Application Server 8.5"


	
Section 3.8, "Creating a New Profile for the WebSphere Application Server"


	
Section 3.9, "Manually Generating a Plug-in"






3.1 Before You Begin

Before you begin the installation of WebSphere 8.5 on IBM i systems, you should perform the steps in this section.

	
All editions of WebSphere Application Server V8.5 use the Installation Manager 1.5.3 to install and maintain the product.


	
Review the installation checklist at the below link and apply any requested PTFs:

http://pic.dhe.ibm.com/infocenter/wasinfo/v8r5/index.jsp?topic=%2Fcom.ibm.websphere.installation.nd.iseries.doc%2Fae%2Ftins_is_check.html


	
Download all the required software from the JD Edwards Update Center.


	
Install the required IBM WebSphere SDK Java Technology Edition 7.0. This JDK is available in these versions depending on the bitness of your system:

	
IBM WebSphere SDK 7.0 32 bit (5761-JV1 option 14), PTF SI46212


	
IBM WebSphere SDK 7.0 64 bit (5761-JV1 option 15), PTF SI46211

[image: Surrounding text describes java_bitness.gif.]




	
The following table lists the IBM i Group PTFs that are included in the WebSphere Application Server Group PTF, along with the versions, that were tested with WebSphere Application Server V85 for IBM i.





	Area	Group PTF Number	Group PTF Level Tested
	
	
	WebSphere 8.5	WebSphere 8.5.5
	Database	SF99701	#12	#24
	Java	SF99572	#7	#14
	IBM HTTP Server	SF99368	#11	#21










3.2 Installing WebSphere Products using Command Line

This section discusses these topics:

	
Section 3.2.1, "Installing the IBM Installation Manager using the Command Line"


	
Section 3.2.2, "Installing WebSphere Express or Network Deployment using the Command Line"






3.2.1 Installing the IBM Installation Manager using the Command Line

Use this procedure to install the IBM Installation Manager using the command line.

	
Download and expand the Installation Manager assembly (zip file) to your IBM i system. For example:

/home/was85/im


	
Run these commands from Qshell:


$ cd /home/was85/im
                        $ umask 022
$ installc -acceptLicense -log ../im.install_log.txt


The IBM Installation Manager is installed to this directory on your IBM i system:

/QIBM/ProdData/InstallataioManager









3.2.2 Installing WebSphere Express or Network Deployment using the Command Line




	
Caution:

Before you perform this procedure, you must have previously installed the IBM Installation Manager as described in the previous section of this guide entitled: Section 3.2.1, "Installing the IBM Installation Manager using the Command Line".







Fix Pack 8.5.5 can be installed as a new installation or an update. For purposes of this procedure, all references are to release 8.5, but you can substitute 8.5.5 where applicable

Use this procedure to install WebSphere Express or Network Deployment using the command line.

	
Expand the WebSphere Application Server zip file into a common directory. After all files are unzipped to a single directory, the directory should look similar to the following:

[image: Surrounding text describes was_unzipped.gif.]

	
Start Qshell:

$ STRQSH


	
Change directory to the location to the tools folder of the Installation Manager. For example:

$ cd /QIBM/ProdData/InstallManager/eclipse/tools


	
Enter the following command based on the product you want to install (where the bolded section is the variable that specifies the product):

ND Installations


$ imcl install com.ibm.websphere.ND.v85 -repositories /home/was85 -installationDirectory /QIBM/ProdData/WebSphere/AppServer/V85/ND -sharedResourcesDirectory /QIBM/UserData/InstallationManager/IMShared -acceptLicense -showProgress


BASE Installations


$ imcl install com.ibm.websphere.BASE.v85 -repositories /home/was85 -installationDirectory /QIBM/ProdData/WebSphere/AppServer/V85/BASE -sharedResourcesDirectory /QIBM/UserData/InstallationManager/IMShared -acceptLicense -showProgress


EXPRESS Installations


$ imcl install com.ibm.websphere.EXPRESS.v85 -repositories /home/was85 -installationDirectory /QIBM/ProdData/WebSphere/AppServer/V85/EXPRESS  -sharedResourcesDirectory /QIBM/UserData/InstallationManager/IMShared -acceptLicense -showProgress


Upon completion, the IBM i system indicates the product is installed, as shown in the following example for a ND installation:

[image: Surrounding text describes install_nd_example.gif.]

	
Enter the following command to review the installed products:

imcl listInstalledPackages -long

The below example shows returned results for an IBM i system with WebSphere Express and ND installed.

WebSphere 8.5

[image: Surrounding text describes install_nd_example2.gif.]

WebSphere 8.5.5

[image: Surrounding text describes install_nd_ex_was855.gif.]










3.3 Installing WebSphere Products using iRemoteInstall Command

This section discusses these topics:

	
Section 3.3.1, "Understanding the iRemoteInstall Command"


	
Section 3.3.2, "Installing the IBM Installation Manager using the iRemoteInstall Command"


	
Section 3.3.3, "Installing WebSphere Express or Network Deployment using the iRemoteInstall Command"


	
Section 3.3.4, "Verify the Installation"






3.3.1 Understanding the iRemoteInstall Command

The iRemoteInstall.bat program is located in this folder in either the ND or Supplement images:

/Remote_Installation_Tool_for_IBM_I

The syntax of the iRemoteInstall command is shown below:

[image: Surrounding text describes iremote_command_syntax.gif.]





3.3.2 Installing the IBM Installation Manager using the iRemoteInstall Command

Fix Pack 8.5.5 can be installed as a new installation or an update. For purposes of this procedure, all references are to release 8.5, but you can substitute 8.5.5 where applicable.

Use this procedure to install the IBM Installation Manager using the iRemoteInstall command.




	
Note:

This procedure must be performed from a Microsoft Windows machine.







	
On a Microsoft Windows machine, download this Installation Manager zip file:

InstMgr_IBM_I_WAS_8.5.zip




	
Note:

You do not need to unzip this file.








	
Download these WebSphere Application Server for Network Deployment (ND) zip files:

WAS_ND_V8.5_1 of 3.zip

WAS_ND_V8.5_2 of 3.zip

WAS_ND_V8.5_3 of 3.zip


	
Unzip the above downloaded files.


	
Locate the iRemoteInstall.bat file from the WebSphere product directory. For example:

Z:\software\ND\Remote_Installation_Tool_for IBM_i


	
Open a Microsoft Windows command line window As Administrator.


	
Enter this command to install the IBM Installation Manager:

iRemoteInstall.bat -hostname <your_host> -username <userid> -password <password> -iminstkit <location of the Installation Manager zip file>

The following example shows an example of the command and the results of its execution.

[image: Surrounding text describes iremote_command_example.gif.]








3.3.3 Installing WebSphere Express or Network Deployment using the iRemoteInstall Command

Use this procedure to install WebSphere Express or Network Deployment using the the iRemoteInstall command.

	
On a Microsoft Windows machine, download these WebSphere Application Server zip files:

WAS_ND_V8.5_1 of 3.zip

WAS_ND_V8.5_2 of 3.zip

WAS_ND_V8.5_3 of 3.zip


	
Unzip the above downloaded files.


	
Locate the iRemoteInstall.bat file from the WebSphere product directory. For example:

Z:\software\ND\Remote_Installation_Tool_for IBM_i


	
Open a Microsoft Windows command line window As Administrator.


	
Enter this command to install the WebSphere Application Server:

iRemoteInstall.bat -hostname <your_host> -username <userid> -password <password> -wasoid ND -wasrepoloc Z:\Software\was85\ND -wasinstloc /QIBM/ProdData/WebSphere/AppServer/V85/ND

The following example shows an example of the command and the results of its execution.

[image: Surrounding text describes iremote_command_example2.gif.]








3.3.4 Verify the Installation

You can view the installed products using this command:

./imcl listInstalledPackages -long

You can also verify the installation thru Work with License Program. For example, that program returns results similar to those shown in this example:

[image: Surrounding text describes license_program_results.gif.]







3.4 Installing and Configuring the IBM HTTP server

The IBM HTTP Server is installed under the license program 5770DG1. You should apply the required group PTF as listed in the following table:


	Area	Group PTF Number	Group PTF Level Tested
	IBM HTTP Server	SF99368	#11










3.5 Applying Updates to the WebSphere Application Server 8.5

This section discusses these topics:

	
Section 3.5.1, "Applying Updates from the Command Line"


	
Section 3.5.2, "Applying Updates using the iGSC WebSphere8xScripts Utility"






3.5.1 Applying Updates from the Command Line

After you have installed WebSphere Application Server, you should verify if any updates or iFixes are required.

Product fix packs contain bundled service to bring WebSphere Application Server up to a new product level. Interim fixes provide corrective service for specific known problems. You can use the IBM Installation Manager command-line function to update the product with the fixes that are available for your service level of WebSphere Application Server version 8.5.




	
Note:

You cannot use the iRemoteInstall command to install a fix pack.







Use this procedure to apply updates to the WebSphere Application Server:

	
Download a file that contains the fix pack from Fix Central, and use local updating.


	
Transfer the compressed fix file in binary format to the IBM i systems on which it will be installed.


	
Extract the compressed repository file to a directory on your system.


	
Sign on to the IBM i system with a user profile that has *ALLOBJ and *SECADM special authorities.


	
Stop all servers and applications on the WebSphere Application Server installation that is being updated.


	
On a CL command line, run the STRQSH commands to start the Qshell command shell.


	
Make suer that the umask is set to 022.


	
Change to this directory:

<Installation_manager>/eclipse/tools


	
Install the fix pack using this command:

./imcl install <offering_ID_offering_version -repositories <location_of_expanded_files> -installationDirectory <product_installation_locatin> -acceptLicense


	
Verify by installation by using this command to list all installed packages:

./imcl listInstalledPackages -log









3.5.2 Applying Updates using the iGSC WebSphere8xScripts Utility

Use this procedure to apply updates to WebSphere Application Server using the iGSC WebSphere8xScripts Utility.




	
Note:

This utility can also update the IBM Installation Manager










	
Caution:

In order to install the fix pack updates, you must have the fix pack group PTF loaded on the system.







	
Download the iGSC WebSphere8xScripts utility as described below:

	
Create this directory on your system:

/Websphere8xScripts


	
Navigate to this IBM download location:

http://public.dhe.ibm.com/services/us/igsc/cta/websphere/


	
Save the Websphere8xScripts.zip file into the directory /Websphere8xScripts you created in the first step of this procedure.


	
Within the directory that you placed the downloaded .zip file for the scripts, unzip the files using this command:

jar -xvf Websphere8xScripts.zip


	
Execute this shell script:

WasInstallMenu.sh




[image: Surrounding text describes wasinstallmenu.gif.]

	
On WebSphere Application Server Install/Uninstall/Fix Pack Menu, enter the number of the task to perform.











3.6 Verifying SDK 7.0 on WebSphere Application Server 8.5

JD Edwards EnterpriseOne supports WebSphere Application Server 8.5 running with SDK 7.0 only. You must switch the java level after the installation is completed.

Starting with WebSphere Application Server 8.5, SDK 7.0 is supported as an optional feature. The java 1.6 is still the default installation.

Use this procedure to verify the java level:

	
Locate the managesdk command which is located in the bin directory of your profile. For example:

/QIBM/ProdData/WebSphere/AppServer/V85/ND


	
Use this command to view the available Java products:

managesdk -listAvailable

Below is an example of the returned results from this command:

[image: Surrounding text describes installed_products_command.gif.]




	
Note:

SDK 1.6 is always installed.








	
Use this command to view the available Java products with details information:

managesdk -listAvailable -verbose

Below is an example of the returned results from this command:

[image: Surrounding text describes installed_products_command2.gif.]




	
Note:

SDK 1.6 is always installed.










The following examples demonstrate correct syntax when you run the managesdk command:

managesdk -listAvailable [-verbose]

managesdk -listEnabledProfile -profileName AppSrv01 [-verbose]

managesdk -listEnabledProfileAll [-verbose]

managesdk -enableProfile -profileName AppSrv01 -sdkname 1.7_64 -enableServers

managesdk -enableProfileAll -sdkname 1.7_64 -enableServers

managesdk -getNewProfileDefault [-verbose]

managesdk -setNewProfileDefault -sdkname 1.7_64

managesdk -getCommandDefault [-verbose]

managesdk -setCommandDefault -sdkname 1.7_64






3.7 Switching to SDK 7.0 on WebSphere Application Server 8.5

The section provides examples that demonstrate the sequence of commands to use to:

	
Section 3.7.1, "List Available SDKs"


	
Section 3.7.2, "Change the Default SDK to Version 7.0 SDK"


	
Section 3.7.3, "Set New Profile Default to Version 7.0 SDK"


	
Section 3.7.4, "Set Existing Profile Default to Version 7.0 SDK"


	
Section 3.7.5, "Modify the JD Edwards EnterpriseOne Server Manager Agent with JRE 1.7.0"






3.7.1 List Available SDKs

Issue this command to view a list of available SDK names for the product installation:

./managesdk -listAvailable

The following is an example of the returned results from this command:

[image: Surrounding text describes installed_sdks.gif.]





3.7.2 Change the Default SDK to Version 7.0 SDK

Issue this command to change the default SDK to Version 7.0 SDK:

./managesdk -setCommandDefault -sdkname 1.7_64

The following is an example of the returned results from this command:

[image: Surrounding text describes set_sdk_version.gif.]





3.7.3 Set New Profile Default to Version 7.0 SDK

Issue this command to change the set the default for new profiles to Version 7.0 SDK:

./managesdk -setNewProfileDefault -sdkname 1.7_64

The following is an example of the returned results from this command:

[image: Surrounding text describes set_new_profiles_default.gif.]





3.7.4 Set Existing Profile Default to Version 7.0 SDK

Issue this command to change the set the default for existing profiles to Version 7.0 SDK:

./managesdk -enableProfileAll -sdkname 1.7_64 -enableServers

The following is an example of the returned results from this command:

[image: Surrounding text describes set_exist_profiles_default.gif.]





3.7.5 Modify the JD Edwards EnterpriseOne Server Manager Agent with JRE 1.7.0

Use this procedure to modify the Server Manager Agent with JRE 1.7.0:

	
Stop the JD Edwards EnterpriseOne Server Manager Agent.


	
Edit the runAgent file to include the location of the jdk70 as specified by the JAVA_HOME setting. For example:

JAVA_HOME=/QOpenSys/QIBM/ProdData/JavaVM/jdk70/64bit


	
Save the runAgent file.


	
Start the JD Edwards EnterpriseOne Server Manager Agent.











3.8 Creating a New Profile for the WebSphere Application Server

Use this procedure to create a new profile for the WebSphere Application Server:

	
On a CL command line, run the STRQSH commands to start the Qshell command shell.


	
Change to this directory:

/QIBM/ProdData/WebSphere/AppServer/V85/ND/bin


	
Use the following command to create a profile:

./manageprofiles -create -templatePath /QIBM/ProdData/WebSphere/AppServer/V85/ND/profileTemplates/default









3.9 Manually Generating a Plug-in




	
Note:

Federated (Clustered) Web Servers. If you are using WebSphere Application Server and running JD Edwards EnterpriseOne as part of a federated (or clustered) web server, you may need to regenerate the WebSphere global plugin configuration after deploying the newest tools release. This is required when new servlets have been added to the tools release you are deploying.
To update (regenerate) plugins, refer to the following procedure.









To update (regenerate) and propagate the global web server plugin configuration:

	
Log on to the Deployment Manager Administration Console using the Dmgr01 profile.

[image: Surrounding text describes was_update_global_plugins.gif.]

	
Expand the Environment node and select Update global Web server plug-in configuration.


	
Review the content in the right-hand pane and note the location of the plug-in file in the description. For example, the description might say:

The global plugin-cfg.xml file is placed in the %was_profile_home%/config/cells directory.


	
Click the OK button.











4 Installing and Configuring WebSphere 7.0




	
Note:

This guide refers to the current IBM hardware and software systems, where the IBM hardware is Power Systems and the operating system is IBM i. Except where specifically noted, in this guide the term "IBM i" refers to both the current and legacy IBM hardware and software products identified in the JD Edwards EnterpriseOne Certifications, including iSeries, AS/400, and OS/400.







Complete these tasks to install and configure WebSphere:

	
Section 4.1, "Determining the Installation Scenario"


	
Section 4.2, "Installing WebSphere 7.0"


	
Section 4.3, "Running WebSphere"


	
Section 4.4, "Generating the Web Server Plug-in"






4.1 Determining the Installation Scenario

Below are two scenarios for installing WebSphere 7.0 on the HTML Server:

	
Section 4.1.1, "Single Machine Scenario"


	
Section 4.1.2, "Multimachine Scenario"




Complete the installation tasks for the scenario that matches your configuration.



4.1.1 Single Machine Scenario

Complete the tasks in this scenario if you have only one machine running the Application Server. The JD Edwards EnterpriseOne Web Server can be on the same machine as the Application Server or on a separate machine.


	Task	Reference Section
	Installing WebSphere 7.0 Application Server	Section 4.2, "Installing WebSphere 7.0"











4.1.2 Multimachine Scenario

Complete the tasks in this scenario if you have multiple machines running the Application Server and one machine running the Deployment Manager.


	Task	Reference Section
	Follow the task list in the Single Machine Scenario to install the Application Server on other machines.	Section 4.2, "Installing WebSphere 7.0"

	Create a Profile	Creating a ProfileSection 4.2.5, "Creating a Profile (Optional)"









	
Note:

To make the Deployment Manager aware of the Application Servers, you must add nodes to the Deployment Manager. See the Network Deployment Guide for JD Edwards EnterpriseOne for specific information about this task.














4.2 Installing WebSphere 7.0

Complete the relevant tasks in this section to install WebSphere 7.0. Do not complete all of these tasks. Instead, determine which of the above scenarios you want to implement, and complete only the tasks listed for that scenario.

	
Section 4.2.1, "Installing WebSphere 7.0"


	
Section 4.2.2, "Installing the WebSphere Update Installer"


	
Section 4.2.3, "Installing the Fix Pack"


	
Section 4.2.4, "Enabling IBM Technology for 32-bit Java Virtual Machines"


	
Section 4.2.5, "Creating a Profile (Optional)"






4.2.1 Installing WebSphere 7.0

Complete the tasks below to install the WebSphere 7.0 Application Server. You must complete all of these tasks for the WebSphere Application Server to run correctly.

Select one of the following two methods to install WebSphere 7.0 on an IBM i machine:

	
Section 4.2.1.1, "Installing WebSphere 7.0 from a workstation (recommended)"


	
Section 4.2.1.2, "Installing the WebSphere 7.0 directly from an IBM i Machine (Not Recommended)"






4.2.1.1 Installing WebSphere 7.0 from a workstation (recommended)




	
Note:

The procedures shown are using the Network Deployment version of WebSphere. Although functionally equivalent for purposes of installation, if you are using the Base version, your procedure will vary accordingly. It is okay to use WebSphere 7.0 Network Deployment CD to install WebSphere Application Server for a base/standalone configuration.










	
Note:

If you have another version of WebSphere, for example 6.1 installed on the same system and it is not running during 7.0 installation, 7.0 installation may assign the same ports used by 6.1 profiles. Either change the ports assign to the 7.0 profile or bring up 6.1 profiles during the 7.0 installation to avoid the port conflict.







To install WebSphere 7.0 from a workstation:

	
Insert the CD for WebSphere Application Server Network Deployment v7.0 for i5/OS into the CD ROM drive of any PC with a Windows operating system.


	
The launchpad will start if autorun function is turned on. If not, navigate to the x:\WAS directory (where x is the letter of the CD ROM drive), and start the launchpad by executing the install.exe file.


	
Click the link entitled: Launch the installation wizard for WebSphere Application Server Network Deployment.

[image: This image is described in surrounding text]

	
When prompted by the wizard, enter the name of the machine, username, and password. For example:


	Field	Value
	Name	DENPBAS2
	Username	QSECOFR
	Password	YOUR_QSECOFR_PASSWORD






	
On the login screen, after you have entered the login credentials, click the OK button to login.

[image: This image is described in surrounding text]

	
On the Welcome screen, click the Next button.

[image: This image is described in surrounding text]

	
On Software License Agreement, accept the License Agreement and click the Next button.

The installer performs a System Prerequisite Check.

[image: This image is described in surrounding text]

	
On System Prerequisites Check, if the system indicates the check passed click the Next button.

[image: This image is described in surrounding text]

	
On Detected JDKs, select the radio button for IBM Technology for JDK6 - 32bit.




	
Note:

The IBM WebSphere 7 installer detects and displays the available JDKs on the IBM i machine. For this installation intended for use with JD Edwards EnterpriseOne you must choose IBM Technology for JDK 6 - 32 bit. After installation, you should only run WebSphere 7 in the 32-bit mode only. For more information, refer to the section of this guide entitled: Section 4.2.4, "Enabling IBM Technology for 32-bit Java Virtual Machines".








	
Click the Next button.

[image: This image is described in surrounding text]

	
On Optional Features Installation, ensure that the Install the Sample applications checkbox is cleared. Install non-English language support as necessary.


	
Click the Next button.

[image: This image is described in surrounding text]

	
On Installation Directory, accept the default installation location, or enter a different path and click the Next button.




	
Tip:

It is recommended that you select the default installation location unless otherwise required.







[image: This image is described in surrounding text]

	
On the WebSphere Application Server Environments, select Application Server to create an Application Server profile. This will create a standalone application server profile called default.




	
Note:

If you are setting up in a federated nodes (that is, cell) configuration, you can create one of two basic types of environments:
	
Cell (deployment manager and a managed node)


	
Management > Deployment Manager













	
Click the Next button.

[image: This image is described in surrounding text]

	
On Enable Administrative Security, the checkbox for the application server profile is checked by default. You can choose either to:

	
Clear the checkbox for Enable administrative security to disable server administrative security, or


	
If the checkbox is enabled for Enable administrative security, server administration security will be enabled and you must enter the User ID and Password

When you enable the checkbox the fields on this screen are enabled and you must enter valid credentials for the WebSphere administrator for this installation.







	
Tip:

JD Edwards EnterpriseOne Business Services Server. If you are using these instructions to install a JD Edwards EnterpriseOne Business Services Server into this WebSphere instance, you must enable administrative security.








	
Click the Next button.

[image: This image is described in surrounding text]

	
On Installation Summary, review the information summary and click the Next button to start the installation process.




	
Tip:

The installation process can take a while to complete and the time taken is dependent on the sizing of your IBM i hardware.







[image: This image is described in surrounding text]

	
On Installation Results, you can click on the AboutThisProfile.txt link to see the port assignment for this profile. Note the Administrative console port on which AppSrv01 will be running (for example, 9060). You can use Profile Management Tool to create as many profiles as you like. Each profile is a separate instance of the WebSphere running on a different set of ports.

[image: This image is described in surrounding text]

The First steps menu is launched.


	
On the First steps menu, click Installation verification to verify the installation.

After you click Installation verification, you can verify the success of the installation by reviewing the contents of the resulting display. For example:


	
Ensure that the Installation Verification utility completes with a success message.


	
Close the First steps output and click Exit on the First steps screen.

This completes the profile creation activity.









4.2.1.2 Installing the WebSphere 7.0 directly from an IBM i Machine (Not Recommended)

To install the WebSphere 7.0 directly from an IBM i machine:

	
Insert the WebSphere Application Server in the CD-ROM drive on the IBM i machine.


	
Start the QSHELL environment using these commands on the IBM i console:

strqsh

cd /QOPT/WebSphere/WAS




	
Note:

Navigation through the directories is not case-sensitive.








	
Start the installation by entering the following command:

Setup -console


	
Replace the installation path or accept this default path:

/QIBM/ProdData/WebSphere/AppServer/V7/ND


	
Select the components to install.


	
Review the summary page and enter [1] to start the install.

Do not exit the Qshell session or signoff until the installation process is complete.

When the message INSTCONFSUCCESS is displayed, the install process is complete.




	
Tip:

The installation process can take a while to complete and the time taken is dependent on the sizing of your IBM i hardware.

















4.2.2 Installing the WebSphere Update Installer

The Update Installer for WebSphere Software includes a new installation program for IBM WebSphere Version 7.0, Installation Wizard starting with Fix Pack 7. Update Installer V7.0.0.7 is backwards compatible. You can use a single instance of the V7.0.0.7 Update Installer to apply maintenance and updates to IBM WebSphere Application Server V7.0.0.x. You can use a single installation of the Update Installer to install maintenance packs on all the WebSphere software products such as WebSphere Application Server, Java SDK, IBM HTTP Server, and Web server plug-ins.




	
Note:

Before installing the WebSphere Update Installer from CD, check IBM WebSphere Application Server v7.0 Fix Pack web site to see if a newer version of the Update Installer is required to install the fix pack. Download and install the newer version of WebSphere Update Installer, if needed.










	
Caution:

Before you can install Refresh or Fix pack for WebSphere software, you need to install the Update Installer engine as described in this procedure.







To install the WebSphere update installer:

	
If you are running WebSphere, stop all the WebSphere processes and then stop the WebSphere subsystem (such as QWAS7).


	
Download the latest Update Installer from IBM web site that match with the update you wish to install to a workstation.


	
Extract the downloaded image to a temporary location and start the launchpad by executing the install.exe file.

[image: This image is described in surrounding text]

	
When prompted by the wizard, enter the name of the machine, username, and password. For example:


	Field	Value
	Name	DENPBAS2
	Username	QSECOFR
	Password	YOUR_QSECOFR_PASSWORD






	
On the login screen, after you have entered the login credentials, click the OK button to login.

[image: This image is described in surrounding text]

	
On the welcome screen, click the Next button.

[image: This image is described in surrounding text]

	
On Software License Agreement, review the License Agreement and select a radio button to accept or decline.

If you chose to accept, click the Next button to continue.




	
Caution:

If you do not accept the terms of the license agreement, you cannot continue with the installation.







[image: This image is described in surrounding text]

	
On System Prerequisites Check, the Installer performs a verification of system requirements.


	
After the Installer indicates the check was successful, click the Next button to continue.

[image: This image is described in surrounding text]

	
On Installation Directory, enter or browse to a valid location where you want to install WebSphere Application Server Network Deployment. For example:

/QIBM/ProdData/WebSphere/UpdateInstaller/V7/UPDI


	
Click the Next button.

[image: This image is described in surrounding text]

	
On Installation Summary, click the Next button to begin the installation.









4.2.3 Installing the Fix Pack




	
Note:

You will have to install the Group PTF based on the WebSphere MTR for the Group PTF. The Group PTF could contain a newer WebSphere Application Server FixPack than the JD Edwards EnterpriseOne Certification for WAS FixPack. Do not use the update installer to apply the WAS FixPack that comes with the group PTF. The WebSphere FixPack should be applied by downloading the required FixPack separately and applied using the steps described in this section.







The installation process for Refresh Packs and Fixpacks is same. Refresh Packs update the base software release level and Fix Packs create minor updates to the Refresh Packs. This task describes the process of installing a Fixpacks, but the same process applies for Refresh Packs as well.

Refer to the Certifications to determine the requirements for your configuration. Apply all the required Refresh Packs and Fixpacks using the following process as an example.

To install the fix pack:

	
If you are running WebSphere, stop the WebSphere processes and the QWAS7 subsystem.


	
Refer to the JD Edwards EnterpriseOne Certifications to determine the supported Fix Packs, and download these supported Fix Packs for WebSphere Application Server 7.0 from the IBM web site.


	
Unzip the downloaded file for the WebSphere Application Server onto a Windows computer.

[image: This image is described in surrounding text.]

	
Map the drive to the IBM i machine. For example:

\\IBMi_machine_name\ROOT

The system requests the user name and password.


	
Copy the Fix Pack to this directory:

/QIBM/ProdData/WebSphere/UpdateInstaller/V7/UPDI/maintenance

A sample screen shot is shown below.

[image: This image is described in surrounding text]

	
Modify install.txt file, which is located in this directory:

/QIBM/ProdData/WebSphere/UpdateInstaller/V7/UPDI/responsefiles

	
Specify the Fix Pack to install (that is, the one that you copied in previous step). For example:


-W maintenance.package="/QIBM/ProdData/WebSphere/UpdateInstaller/V7/UPDI/
maintenance/7.0-7.0.0-WS-WAS-i5osPPC-FP00000xx.pak"


	
Specify WebSphere 7 product directory. For example:


-W product.location="/QIBM/ProdData/WebSphere/AppServer/V7/ND"




A sample screenshot of the install.txt showing the relevant sections is shown below:

[image: This image is described in surrounding text]

	
On the IBM i command line, enter this Start Qshell command:

STRQSH


	
Navigate to this directory:

/QIBM/ProdData/WebSphere/UpdateInstaller/V7/UPDI


	
Enter this command:

./update -options responsefiles/install.txt

The update program runs for several minutes and installs the WebSphere Fix Pack.









4.2.4 Enabling IBM Technology for 32-bit Java Virtual Machines




	
Note:

WebSphere Application Server Network Deployment 7.0 is supported with V6R1 and V5R4 only. EnterpriseOne supports IBM Technology for Java (32-bit JVM) with WebSphere Application Server 7.0. and Classic JVM (64-bit JVM) is also supported with EnterpriseOne and WebSphere Application Server 7.0.







Classic JVM (64-bit JVM) is the default configuration for WebSphere v7.0 on V6R1 and V5R4 i5/OS. Use the steps below to switch to IBM Technology for Java (32-bit JVM)

To enable IBM technology for java (J9 JVM – 32 bit JVM on i5/OS) support:

	
Stop all the WebSphere server processes.


	
Stop this WebSphere 7 subsystem:

QWAS7


	
Open QShell using this command:

STRQSH


	
Change the directory using this command:

cd /QIBM/PRODDATA/WebSphere/AppServer/v7/ND/bin


	
Enter this command:

./enableJVM -jvm std32

Once the command completes successfully the following message is displayed, which indicates that the 32-bit J9 JVM is enabled for all the profiles within WebSphere:

[image: This image is described in surrounding text]

	
Start the application server processes.









4.2.5 Creating a Profile (Optional)

Complete this task to create a profile on the IBM i machine. The installation process of WebSphere 7 may have created profile(s) depending on the environment you selected using this navigation:

Cell > Application Server > Management > Deployment Manager

You can skip this step if you do not need additional profile.




	
Note:

The <WAS_PROD_HOME> directory which is also referenced throughout this guide is typically located in this directory structure:
/QIBM/ProdData/WebSphere/AppServer/V7/ND












	
Note:

The user-specific WebSphere data is maintained in a separate directory, which is also referenced throughout this guide. For example:
<WAS_USER_HOME>

The <WAS_USER_HOME> directory is typically located in this directory structure:

/QIBM/UserData/WebSphere/AppServer/V7/ND/profiles/<profileName>

For example:

/QIBM/UserData/WebSphere/AppServer/V7/ND/profiles/AppSrv01









To create a profile:

	
On the IBM i command line, enter this Start Qshell command:

STRQSH


	
On the Qshell command line, enter this command to change to the directory that contains the script:

cd <WAS_PROD_Home>/bin


	
Enter this command to run the manageprofiles script:

./manageprofiles -create -profileName <profile_name> -templatePath <template_path>

where:

<profile_name> is the name of the profile that is created.

<template_path> is the path to the profile template from which to create the profile.

The following is an example of a command for creating an application server profile that does not have the sample applications installed:

/.manageprofiles -create -profileName AppSrv01 -templatePath /QIBM/ProdData/WebSphere/AppServer/V7/ND/profileTemplates/default

For more information on the manageprofiles script, enter the following command or see IBM Infocenter for IBM i:

./manageprofiles -create -help

http://publib.boulder.ibm.com/infocenter/wasinfo/v7r0/topic/com.ibm.websphere.nd.iseries.doc/info/iseriesnd/ae/tpro_profiles.html


	
After you create a profile, check for the INSTCONFSUCCESS message indicating that the profile creation was successful. Verify the AboutThisProfile.txt file to obtain the list of port numbers.











4.3 Running WebSphere

These tasks describe how to start and stop WebSphere and configure the Administrative Console.




	
Tip:

These tasks are optional before you install the Oracle JD Edwards EnterpriseOne HTML WebServer.







	
Section 4.3.1, "Starting the IBM HTTP Server"


	
Section 4.3.2, "Stopping the IBM HTTP Server"


	
Section 4.3.3, "Starting WebSphere"


	
Section 4.3.4, "Stopping WebSphere"


	
Section 4.3.5, "Using the WebSphere Web Administrative Console"


	
Section 4.3.6, "Testing the WebSphere Application Server"






4.3.1 Starting the IBM HTTP Server

Refer to Section 6.2, "Starting the IBM HTTP Server for the IBM i Instance".






4.3.2 Stopping the IBM HTTP Server

Refer to Section 6.4, "Stopping the IBM HTTP Server for the IBM i Instance".






4.3.3 Starting WebSphere

To start WebSphere:

	
On the IBM i command line, enter this command to start the subsystem:

STRSBS QWAS7/QWAS7


	
On the IBM i command line, enter the Start Qshell command:

STRQSH


	
On the Qshell command line, enter this command to change to the directory that contains the script:

cd <WAS_USER_HOME>/bin


	
Enter the command:

./startServer server1









4.3.4 Stopping WebSphere

To stop WebSphere:

	
On the IBM i command line, enter the Start Qshell command:

STRQSH


	
On the Qshell command line, enter this command to change to the directory that contains the script:

cd <WAS_USER_HOME>/bin


	
Enter this command to stop the server:

./stopServer server1




	
Tip:

To determine if the server is already running, open a command prompt, navigate to the <WAS_USER_HOME>/bin directory, and enter this command:
./serverstatus all












	
Tip:

If the profile is a secure profile to determine if the server is already running, open a command prompt, navigate to the <WAS_USER_HOME>/bin directory, and enter this command:
./serverstatus all -user <WAS_Admin_UserId> -password <WAS_Admin_Password>

















4.3.5 Using the WebSphere Web Administrative Console




	
Note:

WebSphere administration is completely browser-based.







The WebSphere Web Administrative Console is accessible from any supported Web browser. The default URL is

http://<machinename>:<profile_port>/admin

where <machinename> is the name of the server where you installed the WebSphere Application Server, and <profile_port> is the admin port that you used during the profile creation wizard (for, example, 9060).

To check the port number, open this file:

<WAS_USER_HOME>/logs/AboutThisProfile.txt

Search for the value of key Administrative console port.






4.3.6 Testing the WebSphere Application Server

To test the WebSphere Application Server:

	
Ensure that the WebSphere Application Server (default name is server1) is started as explained in Section 4.3.3, "Starting WebSphere".


	
Ensure that the IBM HTTP Server is started.


	
Start a web browser.


	
Enter this URL to test the WebSphere Administration Console:

http://<machine_name>:<http_port>/snoop

where machine_name is the name of the server where you installed IBM HTTP Server, and

where http_port is the port of your IBM HTTP Server. The default value is 80.

For example:

http://localhost:80/snoop




	
Tip:

If your Web Server is not on the same machine as WebSphere, you might need to copy the plug-in configuration file from the WebSphere machine to the Web Server machine.







[image: This image is described in surrounding text]

Upon successful execution, the resulting page should display information similar to the above. This indicates that your WebSphere Application Server is successfully installed and functioning.











4.4 Generating the Web Server Plug-in




	
Note:

If an HTTP server instance has not been created and linked to a WebSphere Application Server profile as shown in the next chapter, no web server will exist.







Whenever you install new enterprise applications, or create new virtual hosts, you must regenerate the Web Server plug-in.

To generate the WebSphere plug-in for a single machine:

	
Log on to the WebSphere Administrative console.

[image: This image is described in surrounding text]

	
On the left navigation pane, select Servers > Web servers.

[image: This image is described in surrounding text]

	
Select the web server for which you want to generate plug-in (for example, IHS_HTTPSVR81), and click the Generate Plug-in button.







	
Note:

Federated (Clustered) Web Servers. If you are using WebSphere Application Server and running JD Edwards EnterpriseOne as part of a federated (or clustered) web server, you may need to regenerate the WebSphere global plugin configuration after deploying the newest tools release. This is required when new servlets have been added to the tools release you are deploying.
To update (regenerate) plugins, refer to the following procedure.









To update (regenerate) and propagate the global web server plugin configuration:

	
Log on to the Deployment Manager Administration Console using the Dmgr01 profile.

[image: Surrounding text describes was_update_global_plugins.gif.]

	
Expand the Environment node and select Update global Web server plug-in configuration.


	
Review the content in the right-hand pane and note the location of the plug-in file in the description. For example, the description might say:

The global plugin-cfg.xml file is placed in the %was_profile_home%/config/cells directory.


	
Click the OK button.











5 Configuring IBM HTTP Server for IBM i to Support the HTML Server




	
Note:

The instructions provided here are general instructions for configuring ports on an IBM HTTP Server for WebSphere running on an IBM i machine.







This section describes these tasks:

	
Section 5.1, "Starting the ADMIN Instance of the IBM HTTP Server"


	
Section 5.2, "Creating a New HTTP Server Configuration"


	
Section 5.3, "Creating a New HTTP Server Instance"







	
Note:

The screen shots in this chapter were captured using a particular HTTP Server PTF and operating system cumulative PTF level, and may not match the screens displayed in your system. Although the placement of links and buttons can vary, the instructions are still applicable. For more information, refer to this link on IBM's website:
http://www-03.ibm.com/systems/i/software/http/











5.1 Starting the ADMIN Instance of the IBM HTTP Server

You must start an ADMIN instance of IBM HTTP Server for IBM i to create, change, or display an IBM HTTP server instance configuration by using the IBM HTTP Server for IBM i Configuration and Administration forms. This section describes these two ways in which you can start the ADMIN Instance of the IBM HTTP Server:

	
Section 5.1.1, "Starting the ADMIN Instance of the HTTP Server from the Command Line"


	
Section 5.1.2, "Starting the ADMIN Instance of the HTTP Server from the Operations Navigator"






5.1.1 Starting the ADMIN Instance of the HTTP Server from the Command Line

To start the ADMIN instance of the HTTP Server from the IBM i command line:

	
From the command line, enter this command:

STRTCPSVR SERVER(*HTTP) HTTPSVR(*ADMIN)


	
Press Enter.









5.1.2 Starting the ADMIN Instance of the HTTP Server from the Operations Navigator

The Operations Navigator is the graphical point-and-click interface to the IBM i system. Operations Navigator is part of the IBM i Access product.

To start the ADMIN instance of the HTTP Server from the Operations Navigator:

	
Start Operations Navigator.


	
Double-click your IBM i server in the main tree view of Operations Navigator.


	
Double-click Network.


	
Double-click Servers.


	
Double-click TCP/IP.


	
Right-click HTTP Administration in the right pane.


	
Select Start from the pop-up menu.











5.2 Creating a New HTTP Server Configuration

WebSphere Application Server plugs into IBM HTTP Server for IBM i. The IBM HTTP Server routes certain client requests (such as for a servlet or JSP file) to WebSphere for processing. You must create a new HTTP server configuration that contains the information that IBM HTTP Server needs to route requests to the appropriate WebSphere Application Server methods.

You can create a new IBM HTTP Server configuration by opening the Configuration and Administration forms.

To create a new HTTP Server configuration:

	
Start your JavaScript-enabled browser.


	
In the URL location or address window, enter this url:

http://<server_name>:2001/HTTPAdmin

where <server_name> is the host name of your IBM i web server machine.


	
Press Enter.


	
You are prompted for an IBM i user ID and password.

You should enter an IBM i user ID that has *ALLOBJ and *IOSYSCFG authority.

The IBM i Web administration page appears as shown in the sample screen below.

[image: This image is described in surrounding text]

	
To create an HTTP Server, click on Create HTTP Server in the left-hand pane.









5.3 Creating a New HTTP Server Instance

You must create a new HTTP Server instance in which an instance of your JD Edwards EnterpriseOne configuration will run.

This section describes these tasks.

	
Section 5.3.1, "Creating a New HTTP Server Instance"


	
Section 5.3.2, "Configuring the WebSphere Plug-in for a Standalone Profile"






5.3.1 Creating a New HTTP Server Instance

To create a new HTTP Server instance:

	
Click on the Setup tab.


	
In the left pane, click on Create HTTP Server.

The Create HTTP server page displays in the right frame, as shown in the screen sample below.

[image: This image is described in surrounding text]

	
On Create HTTP Server, Welcome, complete these fields:

	
Server name

Enter a server name. For example:

HTTPSVR


	
Server description

Enter a description. For example:

HTTP Server for WebSphere





	
Click the Next button.

[image: This image is described in surrounding text]

	
On Create HTTP Server, Server root directory, you can accept the default value.


	
Click the Next button.

[image: This image is described in surrounding text]

	
On Create HTTP Server, IP address and TCP port, complete these fields:

	
IP address

You can accept the default value: All IP addresses.


	
Port

Enter a port number for the HTTP Server. For example, 81.




	
Note:

Since Port 80 is the default port and is already set up with a different web server, you must choose a different port number.










	
Caution:

The port you entered in this field will not be available for use by the JD Edwards EnterpriseOne HTML Web Server. For example, if you plan to use port 84 for your JD Edwards EnterpriseOne HTML Web Server, for this HTTP server definition you must enter a port number other than 84.











	
Click the Next button.

[image: This image is described in surrounding text]

	
On Create HTTP Server, access log, you can accept the default radio button setting of Yes to specify you want your new server to use an access log.


	
Click the Next button.

[image: This image is described in surrounding text]

	
On Create HTTP Server, keep logs, you can accept the default value Keep, do not delete to specify you want to keep the log files.


	
Click the Next button.

[image: This image is described in surrounding text]

	
On Create HTTP Server, summary, review your selections and if acceptable click the Finish button to complete the creation of the HTTP Server.









5.3.2 Configuring the WebSphere Plug-in for a Standalone Profile




	
Note:

This process will not work if the WebSphere profile selected in Step On WebSphere Application Server, on the General tab, select the WebSphere Application Server to which you want to associate. below is a managed node.







To configure the WebSphere plug-in for a standalone profile:

	
Click on the Manage tab.


	
In the left pane, click the WebSphere Application Server link.




	
Note:

If the link is not visible, use the slider bar to scroll down.







[image: This image is described in surrounding text]

	
On WebSphere Application Server, on the General tab, select the WebSphere Application Server to which you want to associate.


	
Select the profile from the profile drop down box.


	
In the field Indicate which installed applications should be mapped to the selected Web server:, use the pulldown to select All Applications.


	
In the field Start All WebSphere application server(s) for the associated WAS instance when this HTTP server is started:, you can accept the default value of No in the drop down box.


	
Click the Apply button.

The program configures the plug-in for WebSphere, and returns to the first default screen.


	
Click the OK button.

The configuration can take several minutes to complete.

The above steps enable the HTTP server to pass requests to WebSphere.


	
Access the WebSphere Administration Console. For example: (for example at ), and click on the servers -> webservers.

http://<server_name>:9060/admin


	
On the WebSphere Administration Console, click on Servers > Webservers.

The program should display the new webserver you created. By default, the server is named:

IHS_<HTTP_SERVER_NAME>

If you following the recommendation in this procedure, the webserver is named:

IHS_HTTPSVR













6 Configuring the IBM HTTP Server

This section includes general instructions for configuring ports on an IBM i IBM HTTP Server for WebSphere 7.0 and 8.5.x, as well as setting up the correct virtual host. Complete these steps only once, then all subsequent installations of JD Edwards HTML Web Server will use the same webserver name that you created using the procedures in this section.

This section describes these tasks:

	
Configuring the IBM HTTP Server


	
Starting the IBM HTTP Server for the IBM i Instance


	
Testing the WebSphere Application Server


	
Stopping the IBM HTTP Server for the IBM i Instance






6.1 Configuring the IBM HTTP Server

To configure the new HTTP Server instance:

	
Open a browser and enter this URL to start the IBM HTTP Server Web Administration console:

http://server_name:2001/HTTPAdmin


	
Click the Manage tab.


	
Select the HTTP Server you created in Creating a New HTTP Server Instance, for example HTTPSVR.


	
In the left pane, scroll down and select Tools > Edit Configuration File.

The configuration file includes a port listen command for the port number you specified when you created the HTTP Server port in Creating a New HTTP Server Instance. This port number might not be the same as the port you specified when you installed the HTML Server. For example, if you selected port 81 as the HTTP Server port, the command in the configuration file should be:

Listen *:81


	
When an instance is installed with JD Edwards EnterpriseOne Server Manager an entry is added into the httpd.conf file to include the contents of the scf_<INSTANCE_NAME>.conf file. You can verify this by checking for the following line in the httpd.conf file (usually at the end of the file):

Include /www/HTTPSVR81/conf/scf_<INSTANCE_NAME>.conf

Where <INSTANCE_NAME> is the name of the created JD Edwards HTML Web Server (HTML Server) instance (for example, EA_JS_101 and so on).

Refer to the sample screenshot below showing the include directive in the httpd.conf file.

[image: This image is described in surrounding text]

	
Click the Apply button.


	
Click the OK button.


	
In the Configuration file, add this directive to the end of the file:


<Directory "/QIBM/UserData/WebSphere/AppServer/V7/ND/profiles/default/
installedApps/DENPBAS2/EA_JS_202.ear/webclient.war/WEB_INF">


This directive allows access to the webclient.war directory.


	
To secure your configuration file, deny access to the WEB-INF directory by adding following to the configuration file, after the above directive.


<Directory "/QIBM/UserData/WebSphere/AppServer/V7/ND/profiles/default/
installedApps/DENPBAS2/EA_JS_202.ear/webclient.war/WEB_INF">
Order Deny,Allow
Deny from All
</Directory>


	
Click the Apply button.


	
Click the OK button.




	
Tip:

You can click on Display configuration file to look and review the contents of the configuration file. An example screen shot is shown below.
Click the Close button.









[image: This image is described in surrounding text]

	
Click the Close button.









6.2 Starting the IBM HTTP Server for the IBM i Instance

The IBM HTTP Server for IBM i runs in the QHTTPSVR subsystem, and each HTTP server instance starts multiple jobs. The WebSphere Application Server code that plugs into IBM HTTP Server for IBM i runs in the HTTP server job that communicates with the administrative server and one or more application servers.

There are two ways to start the IBM HTTP Server for IBM i instance:

	
Starting the IBM HTTP Server for IBM i Instance from the Command Line


	
Starting the IBM HTTP Server for IBM i Instance from the IBM i Configuration and Administration Forms






6.2.1 Starting the IBM HTTP Server for IBM i Instance from the Command Line

To start the IBM HTTP Server for IBM i Instance from the command line:

	
On the IBM i command line, enter this command:

STRTCPSVR SERVER(*HTTP) HTTPSVR(MYINSTANCE)

where MYINSTANCE is the name of your HTTP server instance. The syntax of this name should correspond with the recommended naming conventions specified in this guide. For example:

HTTPSVR


	
If you change your HTTP server instance configuration, stop and then start your HTTP server instance.









6.2.2 Starting the IBM HTTP Server for IBM i Instance from the IBM i Configuration and Administration Forms

The Configuration and Administration forms also allow you the option of restarting your HTTP server instance. When restarting, the HTTP server will recognize all configuration changes except for changes to the Basic and Security configuration forms.

	
Start your JavaScript-enabled browser.


	
Enter this URL in the URL location or address window:

http://<server_name>:2001/HTTPAdmin

where <server_name> is the host name of your IBM i system.


	
Press Enter to navigate to the URL.

The IBM i Tasks page appears.


	
Click the link for IBM HTTP Server for IBM i.

The IBM HTTP Server for IBM i page appears.


	
Click the Manage tab.

The Manage page appears.


	
In the right pane, click Manage All Servers.


	
Click the radio button to the left of the server you created.


	
Click the Start button.

This message appears in the Message box at the bottom of the screen:

HTTP server starting.

A sample screen shot is provided below.

[image: This image is described in surrounding text]










6.3 Testing the WebSphere Application Server

You can test WebSphere by accessing a default application, but a default application requires that Port 80 be configured with WebSphere. You can configure Port 80 with WebSphere using the previous tasks in this chapter.

To test the WebSphere Application Server:

	
Ensure that the IBM HTTP Server is started (as explained in the above section: Starting the IBM HTTP Server for the IBM i Instance).


	
If it is not already started, start WebSphere default server (server1) using the instructions in the chapter: Starting WebSphere.


	
Access the default snoop servlet using this URL:

http://MachineName/snoop

where MachineName is the name of the server where you installed the HTTP Server.




	
Tip:

If your Web Server is not on the same machine as WebSphere, you might need to copy the plug-in configuration file from the WebSphere machine to the Web Server machine.















6.4 Stopping the IBM HTTP Server for the IBM i Instance

If you change your HTTP server instance configuration, stop and then start your HTTP server instance.

There are two ways to stop the IBM HTTP Server for the IBM i instance:

	
Stopping the IBM HTTP Server for IBM i Instance from the Command Line


	
Stopping the IBM HTTP Server for IBM i Instance from the IBM i Configuration and Administration Forms






6.4.1 Stopping the IBM HTTP Server for IBM i Instance from the Command Line

To stop the IBM HTTP Server for IBM i instance from the command line:

	
Enter this command on the IBM i command line:

ENDTCPSVR SERVER(*HTTP) HTTPSVR(MYINSTANCE)

where MYINSTANCE is the of name your HTTP server instance.









6.4.2 Stopping the IBM HTTP Server for IBM i Instance from the IBM i Configuration and Administration Forms

To stop the IBM HTTP Server for IBM i instance from the IBM i configuration and administration forms:

	
Start your JavaScript-enabled browser.


	
Enter this command in the URL location or address window:

http://<server_name>:2001/HTTPAdmin

where <server_name> is the host name of your IBM i system.


	
Press the Enter button.

You are prompted for an IBM i user ID and password; your IBM i user ID must have *ALLOBJ authority.

The IBM i Tasks page appears.


	
Click IBM HTTP Server for IBM i.

The IBM HTTP Server for IBM i page appears.


	
In the top pane, click Administration.

The Administration page appears.


	
Click Manage HTTP Servers in the left-hand frame.


	
Click the radio button to the left of the server you created.


	
Click the Stop button.

This message appears in the Message box at the bottom of the screen:

HTTP server ended.

A sample screen shot is shown below.

[image: This image is described in surrounding text]












7 Running the HTML Server

This chapter contains the following topics:

	
Section 7.1, "Starting the HTML Server"


	
Section 7.2, "Stopping the HTML Server"


	
Section 7.3, "Accessing the HTML Server"


	
Section 7.4, "Generating Serialized Objects for the HTML Server"


	
Section 7.5, "Configuring the HTML Server for Non-Western European Languages"


	
Section 7.6, "Enabling the Browser Side Debugging Feature on the Web Client"


	
Section 7.7, "Customizing the Disclaimer for the Sign-In Page"


	
Section 7.8, "Setting Up Quick Links for Pervasive Device Support"


	
Section 7.9, "Clearing File Attachments from the Browser Cache"







	
Tip:

In order to enable any modifications, you should always stop and restart the Application Server any time you modify the configuration.










	
Note:

Beginning with Tools Release 8.97, many administrative tasks (such as starting and stopping services) for both the HTTP server and the JD Edwards EnterpriseOne HTML Web server can be performed through the Server Manager Console.









7.1 Starting the HTML Server

The JD Edwards EnterpriseOne HTML Server is installed in the instance of the application server that you defined when you installed the Web Server (for example, AS_JS_81). Complete this task to start the server.

To start the HTML Server:

	
Start the Server Manager console.


	
Select the Server and Instance you want to start.


	
Select the Start button.









7.2 Stopping the HTML Server

The JD Edwards EnterpriseOne HTML Server is installed in an instance of the application server that you defined when you installed the Web Server. Complete this task to stop the server.

To Stop the HTML Server:

	
Start the Server Manager console.


	
Select the Server and Instance you want to stop.


	
Select the Stop button.









7.3 Accessing the HTML Server

You can access the HTML Server from any web browser connected to your network.




	
Tip:

	Make sure the installedApps directory and all subdirectories have *public authority, so that users can access applications stored in this directory:
/QIBM/UserData/WebSphere/AppServer/V7/ND/profiles/<profile_name>/bin

Complete these steps:

	
Start your QSHELL environment using this command:

strqsh


	
Change the directory to:

/QIBM/UserData/WebSphere/AppServer/V7/ND/profiles/default


	
Enter this command to assign permission recursively to the installedApps directory and all its subdirectories:

chmod -R 755 installedApps




Do not assign the same permission to the Default directory.


	
To access a HTML Server using non-default host, you must specify a port number, although you do not have to specify index.html.












To access the HTML Server:

	
Open the JD Edwards HTML client by opening a browser and entering this URL:

http://<web_server_name>:<port_number>/jde/owhtml or

http://<web_server_name>:<port_number>/jde/E1Menu.maf

For example:

http://jdewebs1.jdedwards.com:81/jde/owhtml or

http://jdewebs1.jdedwards.com:81/jde/E1Menu.maf









7.4 Generating Serialized Objects for the HTML Server

Starting with application release 8.12, JD Edwards EnterpriseOne specs are delivered in XML format, which allows for on-demand generation of serialized Java objects from these XML specs. Objects are now automatically generated when the first user accesses an application, and the only objects not automatically generated are FDA-created portlets.

eGenerator can still be used to manually generate serialized objects. eGenerator is the only method for generating FDA-created portlets, so it is required if you installed a Portal and created portlets in the FDA application.

To install the eGenerator and manually generate serialized objects, refer to Appendix A, "Generating JD Edwards EnterpriseOne Serialized Objects".






7.5 Configuring the HTML Server for Non-Western European Languages

If you are setting up the HTML Server to run Non-Western European Languages, complete this task to ensure that the Application Server is properly configured for Unicode.

To configure the HTML Server for Non-Western European Languages:

	
Open the WebSphere Administrative Console, and select the Application Server for the JD Edwards HTML Server.


	
Using Server Manager, verify this code page parameter and setting:

codePage=1252









7.6 Enabling the Browser Side Debugging Feature on the Web Client

In past releases, a user working on a form in the web client could press the Ctrl+D keys to display GUI elements at the bottom of the page that are used for browser side debugging. Starting with release 8.96, this feature is disabled in the default mode, and the web client no longer displays this debugging feature when Ctrl+D is pressed. To enable this feature for developers and support personnel, the system administrator must modify the JDEDTA.js file as described in this task.

To enable the browser side debugging feature:

	
On the HTML Server, navigate to the webclient.war/js/ directory, and open the JDEDTA.js file in a text editor.


	
Search for the following line:

var allowDebug=false;

and change the value to true.


	
Save the file.

You do not need to restart the server to activate the change.


	
Open Internet Explorer, and press the Refresh button to reload the page.

This action refreshes the .js files cached in the browser to activate the Ctrl-D feature.









7.7 Customizing the Disclaimer for the Sign-In Page

When web-based clients log on to JD Edwards EnterpriseOne, the sign-in page includes a default disclaimer that is included in a file shipped with the HTML Server software. This task describes how to modify this file to include your own disclaimer.

To specify an additional disclaimer for the sign-in page:

	
Open this file in a text editor:

<JAS_HOME>\webcontent\share\html4login.jsp

where <JAS_HOME> is the installation directory of the HTML Server.


	
Make a backup of this file.


	
Locate the following line and specify your disclaimer with the following element:

String companyDisclaimerHTML = "";

For example:

String companyDisclaimerHTML = "By signing in, you agree to the <a href=\"http://server/path-to/privacypolicy.html\">privacy policy</a>.";




	
Tip:

This element is Java code. Therefore, quotation marks must be preceded by a back-slash character, as shown above.








	
Save the file.

Your changes should take effect immediately. If not, restart the portal.









7.8 Setting Up Quick Links for Pervasive Device Support

JD Edwards EnterpriseOne offers support for Pervasive Devices. Developers can write custom applications for PocketPC 2003 devices using the EnterpriseOne toolset. However, JD Edwards EnterpriseOne menus are not supported on Pervasive Device clients, so a new XML file (PervasiveAppQuickLinks.xml) was added to the HTML Server that allows a system administrator define the list of applications that can be executed on the Pervasive Device client. This file can be edited to add, modify, or delete JD Edwards EnterpriseOne applications that are accessible to Pervasive Device clients. Each application listed in this file is defined by a quick-link tag that describes the application, form, and version of the object, and includes a description. A sample quick-link tag is shown below:


<quick-links>

<quick-link launchAction="launchForm"
                  appID="P0411"
                  formID="W0411G"
                  version="ZJDE0001"
                  description="3 G0411 - Standard Voucher Entry 
                  (P0411_W0411G_ZJDE0001)"/>

</quick-links>


Quick-link tags can include the following attributes:


	Attribute	Required?	Description
	launchAction	yes	Specifies the action that occurs when users click on the quick-link. Valid values are:
	
launchForm

Launch the form directly.


	
promptForValue

Request values for the processing options.


	
promptForVersion

Request which version of the form to open.





	appID	yes	Program number of the application. For UBE type objects, the AppID is the UBE name.
	appType	Required for promptForVersion action.	Type of application.
Valid values are:

	
APP


	
UBE





	formID	Required for launchForm and promptForValue actions. Also required with the appType attribute.	Number of the specific form within the application.
	version	No	Version number of the form.
	description	Yes	Description of the form. This description appears in the list displayed on the Pervasive Device client.






To edit the PervasiveAppQuickLinks.xml file 

	
On the HTML Server, navigate to this directory: <JAS_Home>/installedApps/<node_name>/EA_JS_81.ear/webclient.war/classes.

Open the PervasiveAppQuickLinks.xml file in a text editor.


	
Add quick-link tags for each of the JD Edwards EnterpriseOne applications you want to make accessible to Pervasive Devices.

You can also delete or modify existing tags to remove or change the forms that Pervasive Device clients can access. When clients access JD Edwards EnterpriseOne from a Pervasive Device, the forms are listed as links in the same order they appear in the PervasiveAppQuickLinks.xml file.




Save and exit the file.

Below is an example of the PervasiveAppQuickLinks.xml file:


<?xml version="1.0" encoding="UTF-8" ?> 
<quick-links>
  <quick-link launchAction="launchForm" appID="P0411" formID="W0411G" 
version="ZJDE0001" description="3 G0411 - Standard Voucher Entry 
(P0411_W0411G_ZJDE0001)" /> 
  <quick-link launchAction="launchForm" appID="P01012" 
formID="W01012B" version="ZJDE0001" description="P01012_W01012B" /> 
  <quick-link launchAction="promptForValue" appID="P01012" 
formID="W01012B" version="ZJDE0001" mode="1" appType="APP" 
description="Prompt for Values(P01012_W01012B,ZJDE0001,1,APP)" /> 
  <quick-link launchAction="promptForValue" appID="P4210" 
formID="W4210E" description="Prompt for Values(P4210_W4210E)" /> 
  <quick-link launchAction="promptForVersion" appID="P01012" 
formID="W01012A" appType="APP" description="Prompt for 
Version(P01012_W01012A)" /> 
  <quick-link launchAction="promptForVersion" appID="R0006P" 
appType="UBE" description="Prompt for Version(R0006P)" /> 
  <quick-link launchAction="launchForm" appID="P98TREE" 
formID="W98TREEA" description="P98TREE_W98TREEA" /> 
  <quick-link launchAction="launchForm" appID="P98SYSGR" 
formID="W98SYSGRB" description="P98SYSGR_W98SYSGRB" /> 
  <quick-link launchAction="launchForm" appID="P98CTRL" 
formID="W98CTRLA" description="P98CTRL_W98CTRLA" /> 
  <quick-link launchAction="launchForm" appID="P98RUNPC" 
formID="W98RUNPCM" description="P98RUNPC_W98RUNPCM" /> 
  <quick-link launchAction="launchForm" appID="P98SYSFM" 
formID="W98SYSFMA" description="P98SYSFM_W98SYSFMA" /> 
  <quick-link launchAction="launchForm" appID="P98SYSFM" 
formID="W98SYSFMB" description="P98SYSFM_W98SYSFMB" /> 
  <quick-link launchAction="launchForm" appID="P98FRMFL" 
formID="W98FRMFLA" description="P98FRMFL_W98FRMFLA" /> 
  <quick-link launchAction="launchForm" appID="P98MEDIA" 
formID="W98MEDIAA" description="P98MEDIA_W98MEDIAA" /> 
  <quick-link launchAction="launchForm" appID="P90CB050" 
formID="W90CB050A" description="P90CB050_W90CB050A" /> 
  <quick-link launchAction="launchForm" appID="P55SFRU1" 
formID="W55SFRU1A" description="P55SFRU1_W55SFRU1A" /> 
  <quick-link launchAction="launchForm" appID="P99WIZ01" 
formID="W99WIZ01B" description="P99WIZ01_W99WIZ01B" /> 
  <quick-link launchAction="launchForm" appID="P99WIZ03" 
formID="W99WIZ03A" description="P99WIZ03_W99WIZ03A" /> 
  <quick-link launchAction="launchForm" appID="PMODAL" 
formID="WMODALA" description="PMODAL_WMODALA" /> 
  <quick-link launchAction="launchForm" appID="P42101" 
formID="W42101C" description="New Sales Order Application" /> 
  </quick-links>






7.9 Clearing File Attachments from the Browser Cache

In a typical environment, file attachments (such as Media Object attachments and JD Edwards EnterpriseOne reports) are automatically cached into the \Temporary Internet Files directory on web-based client machines when these attachments are opened from a browser. This situation allows copies of confidential documents, such as Media Objects, images, and web pages, to proliferate across workstations on which these objects are opened.

To prevent these objects from persisting in the internet cache, administrators should configure the browsers to automatically clear the cache when the client closes the browser. This protection is particularly important in a kiosk environment. The procedure for clearing the cache depends on the type of browser. Refer to the relevant task below to secure the browser used in your system.

In addition to securing the browser cache, Media Object Security was added in 8.96 to ensure that media objects can be secured within the application. For more information on this topic, see "Managing Media Object Security" in the JD Edwards EnterpriseOne Tools Security Administration Guide.

This section describes these tasks:

	
Securing Internet Explorer


	
Securing Safari


	
Securing Mozilla Firefox






7.9.1 Securing Internet Explorer

Complete this task to automatically clear the cache in Internet Explorer.

	
In Internet Explorer, select Tools, Internet Options from the drop down menu.


	
Click the Advanced tab.


	
In the "Settings" box, scroll down to the section labeled "Security," and select the check box next to Empty Temporary Internet Files folder when browser is closed."


	
Click OK to save the change.

This option does not delete cookies, but will clear your cache of other files when you close the browser.




	
Tip:

Access the following web page for more details:
http://www.microsoft.com/windows/ie/using/howto/customizing/clearcache.mspx

















7.9.2 Securing Safari

Activate the Private Browsing feature of Safaris to secure the browser. When activated, no web addresses, personal information, or pages are saved or cached on the browser, and no trace of any activity is recorded.






7.9.3 Securing Mozilla Firefox

Activate the Clear Private Data tool to secure Firefox. This tool allows you to delete all personal data, including browsing history, cookies, Web form entries and passwords with a single click. Mozilla Firefox can also be configured to automatically clear this information when you close the browser.










8 Understanding EnterpriseOne HTML Server Package Discovery

This chapter contains the following topics:

	
Section 8.1, "Overview of EnterpriseOne HTML Server Package Discovery"


	
Section 8.2, "Impacts to End Users"


	
Section 8.3, "Understanding the Manifest"






8.1 Overview of EnterpriseOne HTML Server Package Discovery

Starting with JD Edwards EnterpriseOne release 8.12, EnterpriseOne specs are delivered in XML format. The new format enables the specs to be stored in database tables instead of the TAM files, and is called Shared Object Configuration. In this configuration, both Enterprise Servers and HTML Servers access the same database for the same set of specs.

Before release 8.12, whenever a new package was deployed to the Enterprise Server, you had to install the package on a development client and manually generate serialized objects for the HTML Server. With release 8.12, however, manual generation is now optional. Instead, the JD Edwards EnterpriseOne now automatically generates objects on the fly if they do not exist in the serialized object tables.

When you deploy a package to the Enterprise Server, the HTML Server automatically discovers the new package and purges all serialized records impacted by the package. If a full package is deployed, the HTML Server deletes all serialized object records. If an update package is deployed, the HTML Server deletes only those records that are included in the update package. It also removes the impacted objects from in-memory cache. After the package deployment is complete, when a user accesses an EnterpriseOne object, this object is generated on the fly using the new specs delivered in the package.

To ensure the integrity of the specs, the HTML Server must be configured so that:

	
Each EnterpriseOne JAS instance includes only one path code and one package within the path code.


	
All users accessing a JD Edwards EnterpriseOne HTML Server instance access only one package.


	
Serialized object databases are not shared among multiple EnterpriseOne JAS instances, unless all these instances run on the same path code and same package.









8.2 Impacts to End Users

During package deployment, the HTML Server stops responding to user requests until the package is deployed and serialized objects are purged. During this process, user will not able to log in. Users that are already logged in prior to the package deployment will not be able to launch new forms until the package deployment is complete.






8.3 Understanding the Manifest

Each package now contains a package manifest. The manifest is a record in a new table that is created every time a package is built. The package manifest contains a date/time stamp for the package build and information about the package content. For update packages, it also contains a list of objects included in the package.

Each serialized object table now contains a serialized object manifest. This manifest indicates what specs are used to generate the serialized objects. For example, the manifest includes the name of the package used to generate the serialized objects. To ensure the integrity of the system, all serialized objects are generated from the same package.

When the HTML Server detects a package deployment, it compares the package manifest with the serialized object manifest. If a new package is deployed, the package manifest will be different than the serialized object manifest. The HTML Server purges the serialized objects table of objects listed in the package manifest. The HTML Server then updates the serialized object manifest so it is consistent with the package manifest. This entire process is automatic and does not need administrator involvement.

If you decide to generate objects manually using the eGenerator, you must generate the manifest manually for the discovery process to work. For instructions on how to generate the manifest, see Generating the Serialized Object Manifest in Generating JD Edwards EnterpriseOne Serialized Objects.








A Generating JD Edwards EnterpriseOne Serialized Objects

This appendix describes the tasks to install eGenerator and generate JD Edwards EnterpriseOne JAS objects from a set of JD Edwards EnterpriseOne objects. It contains the following topics:

	
Section A.1, "Generating JD Edwards EnterpriseOne Serialized Objects Overview"


	
Section A.2, "Installing eGenerator"


	
Section A.3, "Working with the eGenerator"


	
Section A.4, "Configuring eGenerator"


	
Section A.5, "Generating the Serialized Object Manifest"


	
Section A.6, "Generating All Standard Serialized Objects"


	
Section A.7, "Generating a List of Objects (Bulk Generation)"


	
Section A.8, "Verifying the Generation Process"


	
Section A.9, "Generating Other Selected Objects"






A.1 Generating JD Edwards EnterpriseOne Serialized Objects Overview

The first step is determine which JDK to use:

	
HTML Server with WebSphere Application Server 7.0

You must use JDK version 1.6 on your eGenerator script.


	
HTML Server with WebSphere Application Server 8.5.x

You must use JDK version 1.7 on your eGenerator script.




	
Note:

If you are running eGenerator on your Development Client for WebSphere 8.5.x, you will need JDK 1.6 32-bit for your Development Client and JDK 1.7 for the eGenerator.










Starting with application release 8.12, JD Edwards EnterpriseOne specs are delivered in XML format, which allows for on-demand generation of serialized objects from these XML specs. Objects are now automatically generated when the first user accesses an application.

eGenerator can still be used to manually generate serialized objects. It is the only method for generating FDA-created portlets, so is required if you installed a JD Edwards EnterpriseOne Portal. eGenerator is also an optional path for generating any set of objects, including a complete set of objects.

The eGenerator allows manual control over the process that turns JD Edwards EnterpriseOne specifications into Java code, which enables you to access JD Edwards EnterpriseOne applications in HTML. The JD Edwards EnterpriseOne forms and applications that you generate, either manually from eGenerator, or automatically using on-demand generation, are serialized Java objects. JD Edwards EnterpriseOne stores these objects in a database (in serialized object tables F989998 & F989999), and retrieves them at runtime.

eGenerator requires a specific machine configuration. While it is possible to configure a web server as the generation machine for release 8.12, you should dedicate a separate generation machine for this process. The configuration of this machine depends on the release of JD Edwards EnterpriseOne you installed.

If you upgraded to JD Edwards EnterpriseOne from a previous release and customized your JD Edwards EnterpriseOne objects, you should first test your custom modifications, then generate serialized JAS objects from the upgraded path code.






A.2 Installing eGenerator

This topic discusses the tasks you follow to install the eGenerator:

	
Section A.2.1, "Prerequisites"


	
Section A.2.2, "Setting the Default Storage Parameter (SQL Server only)"


	
Section A.2.3, "Preparing JD Edwards EnterpriseOne for Serialized Objects"


	
Section A.3.3, "Bypass the Web Server and Generate Serialized Objects Directly to the Serialized Object Tables"






A.2.1 Prerequisites

Before you install the eGenerator, verify that the tasks below are completed for your version of JD Edwards EnterpriseOne:

	
Complete the task: "Copying the JDBC Drivers and the tnsnames.ora file to the Deployment Server" in the JD Edwards EnterpriseOne Development Client Installation Guide.




	
Caution:

This task must be completed by a JD Edwards EnterpriseOne system administrator before you complete any of the tasks below.








	
Install the Web Development Client to set up eGenerator.

If the Web Development Client installs successfully, eGenerator is automatically configured to run without modifying any of the files used in the generation process.

Refer to the JD Edwards EnterpriseOne Development Client Installation Guide.


	
Complete this task if you are using IBM DB2 on the Enterprise Server.

On the Generation machine, open the db2cli.ini file and comment out or remove the LobCachSize parameters under database aliases associated with JD Edwards EnterpriseOne. This file is typically located under DB_HOME\SQLLIB\.









A.2.2 Setting the Default Storage Parameter (SQL Server only)

For SQL Servers databases, the default storage parameter on your JD Edwards EnterpriseOne database might not enable enough space to transfer all the standard JD Edwards EnterpriseOne Java objects. To avoid this problem, complete the task below:

To set the default storage parameter:

	
Open the SQL Server database and set your database Maximum File Size parameter to "Unrestricted filegrowth."

Complete this step for each database (for example, PY900) to which you are installing the Java objects.









A.2.3 Preparing JD Edwards EnterpriseOne for Serialized Objects

Before you generate serialized Java objects in JD Edwards EnterpriseOne, complete this task to link to the JD Edwards EnterpriseOne serialized object tables on the Java generation machine.

Complete this task only if you want to generate serialized objects on a different location other than the datasouce listed in the Object Configuration Manager (OCM). If you choose this option, you can use this procedure to edit the JD Edwards EnterpriseOne Spec database.

	
Sign on to Server Manager Console.


	
Open the database configuration of the HTML instance.

[image: Surrounding text describes jdbj_spec_datasource.gif.]

	
On JDBj Spec Datasource, enter the Spec Datasource information.


	
Save the configuration and restart the HTML instance.











A.3 Working with the eGenerator

This section describes these topics:

	
Section A.3.1, "Running the eGenerator Diagnostic Tool"


	
Section A.3.2, "Generate Using the Web Server"


	
Section A.3.3, "Bypass the Web Server and Generate Serialized Objects Directly to the Serialized Object Tables"




Each method of generation has a specific way to log into eGenerator. Select the task that corresponds to the way you want to generate objects.



A.3.1 Running the eGenerator Diagnostic Tool

eGenerator now includes an application that is automatically launched every time eGenerator is started. This application is a diagnostic tool that checks the configuration of eGenerator and reports incorrect settings. The diagnostic tool categorizes errors into two types: fatal and non-fatal. If a fatal error is detected, the application displays an error message and does not enable eGenerator to launch. If a non-fatal error is detected, the application displays an error message but enables you to continue with the Generation process.




	
Note:

The auto diagnostic tool can be suppressed by launching gen.bat with the -nodiag parameter.







The auto diagnostic tool performs these operations for general use:

The auto diagnostic tool performs these operations for general use for Direct Generation:


	Operation	Fatal Error
	Generates a Web Code Level Object, which is used by JAS at startup to determine if its code matches the generated objects.	X
	Checks the location of the jas.ini file and validates these key parameters in the file.	

	Checks the location of the location of the jas logs.	








For JAS Generation only


	Operation	Fatal Error
	Verifies that the Tools Release of the JAS code on the generation machine matches the Tools Release of the JAS code on the HTML Server (fatal error).	X










A.3.2 Generate Using the Web Server

Complete this task to generate objects using the web server.

	
On your generation machine, select your configuration below, navigate to this directory:

x:\<release>\JAS




	
Note:

If you do not want to run the diagnostic program, include the parameter -nodiag in the command statement when you run launchGen.bat. See the section, Running the eGenerator Diagnostic Tool, for more information about the autodiagnostic tool.








	
From the above directory, run the launchGen.bat file.

[image: Surrounding text describes gen_new002.gif.]

	
On Generator, complete this field:

	
JAS Server Name

Enter machine name:port, where machine name is the name of your web server and port is the port number for the EnterpriseOne instance.





	
Click the Connect button.


	
Enter the login information for JD Edwards EnterpriseOne. After the connection is successful, the eGenerator is properly configured to generate the objects through the Web Server you specified.


	
Select where the specs exist for generation. You can generate specs from a specific set of Central Objects or a particular path code. By default, Default Spec Files will be used. Default Spec Files reside on the local machine.

Choose one of the following options:

	
To generate specs from a particular set of Central Objects:

Click the Central Objects radio button, and enter the Path Code where the specs are stored.

[image: Surrounding text describes gen_new003.gif.]

	
To generate specs from a specific package:

Click the Package radio button, and enter the name of the Package and the DataSource where the specs are stored.

[image: Surrounding text describes gen_new004.gif.]




	
Click Connect.

The system connects to the Web server that you indicated. A message appears on the status bar when login is complete.

Once you have logged in to a Web server, skip the following task and refer to the sections below it for information on how to generate objects.









A.3.3 Bypass the Web Server and Generate Serialized Objects Directly to the Serialized Object Tables

Select direct generation by clicking the Direct Generation radio button in the Connection section on the eGenerator application.

In this mode, the generator initializes a "mini" HTML Web Server instance on the generation machine. During generation, the generator will by-pass the actual HTMl Web Server and store the objects directly to the serialized object tables. After you complete this task, you can set up the HTML Server to read from the pre-populated serialized object tables.

Advantages:

	
Can generate objects before setting up the HTML Server.


	
Faster for all forms of generation.


	
Easier to maintain.




Disadvantages: You must configure the generation machine.

Complete this task to generate objects directly to a database.

	
Run the launchGen.bat file.




	
Note:

If you do not want to run the diagnostic program, include the parameter -nodiag in the command statement when you run launchGen.bat. See the section, Section A.3.1, "Running the eGenerator Diagnostic Tool", for more information about the autodiagnostic tool.







[image: Surrounding text describes gen_new001.gif.]

	
On Generator, click the Direct Generation radio button.

In Direct Generation Mode the eGenerator locates the serialized object database by looking for the database server in the server= setting of the JDBj-SPEC DATA SOURCE section of the jdbj.ini file located on the generation machine.


	
Click the Connect button and enter the login information for JD Edwards EnterpriseOne.

The system bypasses the Web server and connects directly to the database specified in the jdbj.ini file.











A.4 Configuring eGenerator

eGenerator includes a number of options you can set up for your particular environment. The configuration process consists of these tasks:

	
Setting eGenerator Options


	
Choosing Languages


	
Configuring the genapp.ini File






A.4.1 Setting eGenerator Options

Before generating objects, you can define a variety of parameters that affect how the eGenerator functions.

	
From the pull-down menu, select Options > Advanced Settings.


	
On Advanced Settings, select the options appropriate for your generation requirements

[image: Surrounding text describes gen_new005.gif.]

	
Logging

Specify whether to log the generation process by clicking the check boxes next to the Status and Error logs. You can also enter the location of the log files. Logging is crucial for troubleshooting problems with the generation process.


	
Generation Modes

Specify if the generation of All Objects will be done in parallel mode or sequential mode by checking the appropriate radio button.

For more information on Generation Modes, see Generation Modes.


	
User Option

You can generate a public version of the applications or a personal version by choosing the relevant option. Personal versions are only available to the person who created the versions, and are only intended for developers.


	
Protocol Option

Starting with Tool Release 9.1.4, you can choose the HTTPS Protocol connection to the Web Server. You must include the HTML server certificate location in the gen.bat file. The location is set by the -Djavax.net.ssl.trustStore= parameter (bolded) as shown in this example:


%JAVA_PGM% -Xss1m -Xms128m -Xmx512m -Ddefault_path=%INI_DIR% -Djavax.net.ssl.trustStore=Z:/E910/e1keystore -classpath %GEN_CLASSPATH% com.jdedwards.runtime.generator.Generator %1


%JAVA_PGM% -Xss1m -Xms128m -Xmx512m -Ddefault_path=%INI_DIR% -Djavax.net.ssl.trustStore=Z:/E910/e1keystore -classpath %GEN_CLASSPATH% com.jdedwards.runtime.generator.Generator %1









A.4.1.1 Generation Modes

The eGenerator has these modes for generating web objects:

	
Sequential Generation


	
Parallel Generation






A.4.1.1.1 Sequential Generation

In this mode the web objects are generated one after the other when you select the Generate-All Objects option. You can set this mode by clicking Options > Advanced Settings, then clicking Sequential Generation.

Advantages:

	
Most stable mode of generation.


	
Requires the least system resources, e.g. memory.


	
Safe to use during a JITI (Just in Time Install) process.




Disadvantage: The generation process can take longer.






A.4.1.1.2 Parallel Generation

This is the default mode of generation. You can turn off this mode of generation by clicking Advanced Settings, then clicking Sequential Generation.

In this mode of generation the web objects are generated concurrently when you select the Generate-All Objects option

Advantage: Faster than Sequential Generation, especially with multi-processor workstations and fast database connections.

Disadvantages:

	
Cannot be used when the user doesn't have the full set of spec files, because JITI might occur.


	
If a JITI occurs during parallel generation, the spec files can get corrupted.













A.4.2 Choosing Languages

You can generate applications and reports in the language you desire by selecting any of the supported languages on the eGenerator application.




	
Note:

You must install the Language CD for each language you want to use.







To select languages 

	
On eGenerator, select Options > Languages from the pull-down menu.

[image: Surrounding text describes generator_002.gif.]

	
Click the check box next to each of the languages you want to use.


	
Click OK.









A.4.3 Configuring the genapp.ini File

The genapp.ini file contains the list of applications that you want generated in a mode other than the default mode, which is mode 1. In the genapp.ini file, you can list applications you want generated in one of the other modes: Mode 2 or Mode 3.

Do not modify this file unless you created custom applications using Mode 2 or Mode 3.








A.5 Generating the Serialized Object Manifest

The section describes how to generate the manifest for the set of objects in the serialized object tables. For an overview of the serialized object manifest and a description of the package discovery process, refer to Understanding EnterpriseOne HTML Server Package Discovery.

To generate serialized object manifests 

	
From the pull-down menu, select GenerateManifest.

[image: Surrounding text describes manifest_info.gif.]

	
Click Create Manifest.

[image: Surrounding text describes manifest_creation_warning.gif.]

	
Click Yes.

The program creates the manifest and closes the window.


	
To view the manifest that was created, from the pull down menu, select GenerateManifest.

[image: Surrounding text describes manifest_creation_xml.gif.]

The Manifest Info section displays the name of the package, the build date, and the deployment date. This manifest shows that no update packages were deployed.

The Manifest Audit Info field contains information about the user and the machine that created the manifest.









A.6 Generating All Standard Serialized Objects

eGenerator can generate a complete set of Java Serialized Objects from JD Edwards EnterpriseOne objects. These serialized objects enable you access to all JD Edwards EnterpriseOne objects when you run your web server. If, however, you only want to generate a partial set of objects, skip this task and complete the relevant task in the section: Section A.9, "Generating Other Selected Objects".

Complete this task to generate a complete set of JD Edwards EnterpriseOne objects.

	
From the pull-down menu, select File > Core Objects.

For more information on generating core objects, see Section A.9.1, "Generating Core Objects".


	
If the core objects generate successfully, from the pull-down menu, select Generate > All Objects.

[image: Surrounding text describes generator_all_objs.gif.]

	
On Generate All Objects, check all the objects listed.


	
Click the Start button.

eGenerator checks the database connection before it attempts to generate objects.

If it cannot connect to the database, eGenerator displays this screen:

[image: Surrounding text describes gen_check_connection.gif.]

	
If this screen displays, click the Stop button and verify the connection to the database.


	
If the last Generate-All session did not conclude successfully, eGenerator displays a screen with the details of the failed generation.

Select one of these options:

	
To resume the previous generation process, click RESUME OLD SESSION. You should select this option, which restarts the previous process from the point of failure. Once the previous process completes, you can repeat this task to generate the new set of objects.


	
To cancel the previous generation process and generate the new objects, click CREATE NEW SESSION.

Select this option if you are currently generating a complete new set of all object types.




In either case, an object set starts generating. The progress of object generation is displayed on the screen: the blue progress bar indicates the progress of the generation process, and the green progress bar indicates the progress of objects inserted into the database.

If the database insertion of objects is not complete when the generation is done, the eGenerator displays the number of objects remaining in the queue.

Once all the objects are inserted into the database, the program displays a message that the "Generation completed successfully."









A.7 Generating a List of Objects (Bulk Generation)

If you are running EnterpriseOne release 812, the JAS servers generates objects on demand. To reduce the performance impact of on-demand generation, you can manually generate a list of the most frequently used applications from a list defined in a text file, and let other applications or reports to be generated on demand.

A sample text file named BulkGen.txt is included with the HTML Server or Web Development Client under the WEB-INF directory. This file contains sample entries in the format that can be read by the eGenerator. Modify this file to include just the large, frequently used applications.

To run the bulk generation file 

	
Run launchGen.bat.


	
On eGenerator, complete this field:

	
Bulk Generation File: Enter the name of the file, or click Select File, and select the Bulk Generation File.




It may take some time for the system to connect to the file.


	
Select a Connection option (either Direct Generation or JAS Server).


	
Select Default Spec Files.


	
Click Connect.


	
Log on to JD Edwards EnterpriseOne and click OK.


	
From the pull-down menu at the top of the screen, select FileBulk Generation.


	
Click Start.

eGenerator will generate all the objects listed in the file you selected. When the process is complete, eGenerator displays a message: Generation Completed Successfully.







	
Tip:

The update package build generates a GeneratorList.txt file in the work directory of the package. The GeneratorList.txt file is a well formed bulk generation file that lists the objects included in the update package. You can use this file for Bulk Generation after deploying the update package.












A.8 Verifying the Generation Process

Complete these tasks to verify the generation is successful:

	
Checking Log Files


	
Checking Database Acknowledgements






A.8.1 Checking Log Files

eGenerator enables you to automatically display the Status Log and Error Log files by selecting these options from a menu.

To display the Status Log 

	
On eGenerator, select LogsStatus Log from the pull-down menu.




To display the Error Log 

	
On Generator, select LogsError Log from the pull-down menu.









A.8.2 Checking Database Acknowledgements

The status log records whether an object is successfully inserted in the database. This enables the user to monitor the generation process and verify that objects are successfully generated.

These acknowledgments will not be printed for data dictionary Items or Data Structures, however, because they are too numerous to be printed on the command line screen.

Below is an example of the output:


Generating application P01012 ...
-->Database Ack:ER_P01012_W01012D successfully inserted into database
-->Database Ack:P01012_HTML_W01012D successfully inserted into database
-->Database Ack:ER_P01012_W01012B successfully inserted into database
-->Database Ack:P01012_HTML_W01012B successfully inserted into database
-->Database Ack:ER_P01012_W01012A successfully inserted into database
-->Database Ack:P01012_HTML_W01012A successfully inserted into database App
generation finished Generating 2 NERs -->Database Ack: ER_P01012_W01012C
successfully inserted into database -->Database Ack: P01012_HTML_W01012C
successfully inserted into database -->Database Ack: NER_PlugAndPlay_P0101
successfully inserted into database NER generation finished Generating 1 PO
Data Structure Items PO Data Structure generation finished Generating 2
Business Views Business View generation finished Generating 5 Tables Table
generation finished Generating 294 Data Dictionary Items Data Dictionary
generation finished Generating 30 Data Structure Items Data Structure
generation finished -->Database Ack:NER_UpdateChangedGeoCode successfully
inserted into database -->Database Ack: PODATAP01012 successfully inserted
into database -->Database Ack:VIEW_V0101E successfully inserted into
database -->Database Ack: TABLE_F0101 successfully inserted into database
-->Database Ack: TABLE_F0111 successfully inserted into database
-->Database Ack: TABLE_F0116 successfully inserted into database
-->Database Ack: TABLE_F03012successfully inserted into database
-->Database Ack: TABLE_F0401 successfully inserted into database








A.9 Generating Other Selected Objects

When you deploy an update package of JD Edwards EnterpriseOne objects, you can either depend on the on-demand feature of the HTML Server to generate serialized objects, or you can manually generate selected objects using eGenerator. eGenerator includes several methods of generating a partial set of serialized objects. All but one method, "Generating objects using the Bulk Generation File," are performed by selecting options from the eGenerator screen. The Bulk Generation file enables you to type selected objects directly into a text file and run this file in eGenerator.

Complete one of these tasks to generate a partial set of serialized objects.

	
Generating Core Objects.


	
Generating Applications.


	
Generating Forms.


	
Generating Reports.


	
Generating NERs.


	
Generating Data Dictionary Items.


	
Generating Tables.


	
Generating Business Views.


	
Generating Data Structures.






A.9.1 Generating Core Objects

The core objects are the foundation objects required by other JD Edwards EnterpriseOne components. Generating these objects enables the Java server to run Task Explorer and the Portal without installing specific applications.

To generate core objects, on eGenerator, select FileCoreObjects from the pull-down menu.

eGenerator begins generating the core objects and their dependent Data Dictionary Items.

The eGenerator displays the status of the generation once the process is complete.






A.9.2 Generating Applications

Complete one of these tasks to generate one or more applications:

	
From the pull-down menu, select Generate -> Applications.


	
From the pull-down menu, select Generate ->Application.


	
From the pull-down menu, select Generate -> Application.




To generate an application:


	
From the pull-down menu, select Generate -> Applications.

[image: Surrounding text describes generator_gen_apps_by.gif.]

	
Select Application Name, and enter the program number of the application (for example, P01012).


	
Click Start.

The Generator generates all forms contained in the application and all dependent objects used by the application.


	
Check the Status Log for status of generation.




To generate applications by system code


	
From the pull-down menu, select Generate ->Application.


	
Select Generate by System Code, and type the number of the System Code in the field to the right.

[image: Surrounding text describes generator_gen_apps_by.gif.]

	
Click Start.

eGenerator fetches all the applications under that system code.


	
Confirm the applications were generated by checking the status and error logs.


	
Use this SQL command to verify the applications reside in the database:

SQL> select wboid from f989999 where wboid like P%W%;




You can generate applications by modes 1, 2 or 3. These modes determine the look and feel of the applications. For more information on Generation Modes, see the section "Generating Options" in Designing JD Edwards EnterpriseOne Web Applications.

To Generate applications by mode


	
From the pull-down menu, select Generate -> Application.


	
Select a mode.

[image: Surrounding text describes generator_apps_mode3.gif.]

	
Click Application Name, and enter the name of an application (for example, P01012).


	
Click Start.









A.9.3 Generating Forms

To generate a form 

	
From the pull-down menu, select GenerateApplications.


	
Enter the form name in the Form Name field, for example, P01012_W01012A.


	
Click Start.

If the form name is invalid, this error message appears:

[image: Surrounding text describes gen_form_invalid.gif.]

If the application name is invalid, this error message appears:

[image: Surrounding text describes gen_form_invalid_name.gif.]

	
Check the status log for the generation status.









A.9.4 Generating Reports

Complete one of these tasks to generate one or more reports:

	
From the pull-down menu, select Generate -> Reports.


	
From the pull-down menu, select Generate -> Reports.


	
From the pull-down menu, select Generate ->Reports.




To generate a report


	
From the pull-down menu, select Generate -> Reports.


	
Enter the name of a report, (for example, R0006P).


	
Click Start.


	
Check the status log for the generation status.

The Generator generates all versions of the report and their corresponding data selection, data sequencing, and Print Information Objects.


	
Confirm the presence of the objects by checking the Status logs, or use this query to check the database:

SQL> select wboid from f989999 where wboid like %<report_name>%;




To generate a report version


	
From the pull-down menu, select Generate -> Reports.


	
Enter a Report Name and Report Version, for example, R0006P, and XJDE0001.

[image: Surrounding text describes generate_reports.gif.]

	
Click Start.

The Generator generates the version and any dependent objects.


	
Check the status log for the generation status.




To generate reports by system code


	
From the pull-down menu, select Generate ->Reports.


	
Select Generate by System Code, and enter a number for the code.


	
Click Start.

[image: Surrounding text describes generate_reports_by.gif.]

eGenerator fetches all the reports under that system code.


	
Check the status and error logs to confirm that all the reports for that system code were generated.









A.9.5 Generating NERs

To generate NERs 

	
From the pull-down menu, select GenerateNERs.


	
Enter the name of an NER, for example, GetObjectDesc.




	
Note:

NERs are case sensitive.







[image: Surrounding text describes generate_ners.gif.]

	
Click Start.


	
Check the status log for the generation status.


	
Use this SQL command to verify that the objects reside in the database.

SQL> select wboid from f989999 where wboid like <NER_ name>









A.9.6 Generating Data Dictionary Items

To generate Data Dictionary items 

	
From the pull-down menu, select Generate -> Data Dictionary.


	
Generate any data dictionary item, for example, OBNM.

[image: Surrounding text describes generate_dd.gif.]

	
Check the status log for the generation status.


	
Use this SQL command to verify that the objects reside in the database.

SQL> select wboid from f989999 where wboid like 'DICT_<dd_name>';









A.9.7 Generating Tables

To generate tables 

	
From the pull-down menu, select Generate -> Tables.


	
Enter a table number, for example, F9860.

[image: Surrounding text describes generate_table.gif.]

	
Click Start.

eGenerator generates the table and all data dictionary items used by the table.


	
Check the status log for the generation status.









A.9.8 Generating Business Views

To generate business views 

	
From the pull-down menu, select Generate -> Business Views.


	
Enter the name of a business view, for example, e.g. V9001B.


	
Click Start.

eGenerator generates the View and all associated tables and data dictionary items.


	
Check the status log for the generation status.

[image: Surrounding text describes generator_bvs.gif.]








A.9.9 Generating Data Structures

To generate data structures 

	
From the pull-down menu, select Generate -> Data Structures.


	
Enter the name of a data structure, for example, D9800150C.

[image: Surrounding text describes generate_ds.gif.]

	
Click Start.

eGenerator generates the data structure.


	
Check the status log for the generation status.


	
Use this SQL command to verify that the objects reside in the database:

SQL> select wboid from f989999 where wboid like 'DSTR_ <datastructure_name>'













B Understanding Media Objects on the Web Server

This section provides an overview of jas.ini settings required to access Media Objects on the HTML Server, and the process by which the web server accesses these objects from the network. The last section describes how to secure Media Objects on web-based client machines.


B.1 Required jas.ini Settings

Ensure that these parameters are set in the [OWWEB] section of the jas.ini file.


	Parameter	Recommended Setting	Description
	MO QUEUE=	Site-dependent path	Identifies the media object directory location on your HTML Server. This path must translate into virtual path /jde/moqueue/ for the web browser.
	FtpPort=	21	Specifies the default port to be used for FTP.
	FtpUsr=	anonymous	Specifies the user id to be used for FTP access to the media Object File Server.
	FtpPwd=	anonymous	Specifies the password to be used for FTP access to the media Object File Server.
	UseMOWinNTShare=	TRUE
FALSE

	Specifies that the web server use the Microsoft Windows file sharing mechanism for fetching Media Object files from their location into the cached location of the web server.
Specifies that the web server does not use Microsoft Windows file sharing mechanism and uses FTP access instead.

Note: If this setting is TRUE, media object queue paths set in P98MOQUE must be accessible by the owner of the application server from the application server machine (the application server is the server program hosting web servlets). To test the accessibility of a media object queue path, log in as the owner of the application server, open Windows Explorer, and paste the path to the media object queue into the address field. The path should be accessible without entering a user ID and password.

If this path is not accessible, you can change the media object queue setting to a path accessible by the owner of the application server. For example, you can specify a path on the application server machine as the media object queues directory.











B.2 How Media Objects are Displayed by the HTML Server

This section explains how Media Objects are sent to the HTML client by the HTML Server.

	
A user selects attachments on an application which has support for media objects.


	
The Media Object window displays the image, file, or OLE objects, and the user selects one of these objects.

[image: This image is described in surrounding text]

	
The request goes to the web server.


	
The web server reads the location of the object from the Media Object queue table (F98MOQUE), finds the file, and caches it in the location specified by the MO QUEUE path.

If UseMOWinNTShare is TRUE, files are transferred using Microsoft Windows file sharing mechanism, otherwise files are transferred using FTP protocol.




This diagram illustrates the process:

[image: This image is described in surrounding text]
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This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for use in any inherently dangerous applications, including applications that may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.
Third-Party Content, Products, and Services Disclaimer
This software or hardware and documentation may provide access to or information on content, products, and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products, and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or services.
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Choose whether to enable adminisiraiive security. To enable securiy, specifya
user name and passward to log into the administrative tools. The administrative
useris created in a repasitory within the Application Server. After installation
finishes, you can add more users, groups, or extemal repositories.
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See the Information Center for more information about administrative securty.
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WebSphere Application Server Environments

Selectthe type of WebSphers Application Server emvironmentto create during
installation. Although anly ane enviranment tyoe can be chosen, addiional
profles can be created after installation using the Profile Managernent Tool
Emvironments

Cell (deployment manager and a managed node)

Management

Custom
Secure proxy (configuration-onh)
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A stand-alone application server environment runs your enterprise
applications. The application server is managed from its own administrative
console and functions independent of al other application server and
deployment managers.
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Select IBM WehSphere Application Server Netwark Deployment features ta
install. See the InstallGuide_en.htrmi file in the docs directary for detailed
descriptions ofthe optional features

I™ Install the Sample applications.

“The Samples include bioth source code files and integrated enterprise
applications that demonstrate same of the latest Java (TM) Platform,
Enterprise Edition (Java EE) and WebSphere technologies. The samples.
are recommended for installation to learing and demonstration
environments, such as development environments. However, they are not
recommended for installation to production application server
enviranments.

I™ Install non-English language packages for the administrative console.

In addiion to installing the English language fles, you can also install il
the non-English language files needed for using the adminisiraive
console fram machines with non-English lacales.
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Servername:  HTTPSVR
Server description: HTTP Server for WebSphere.
Server root: wwhitpsvr
Documentroot:  Mwwwhipsviitdocs

1P address: AllIP addresses

port. 81

Logdirectory:  Awwwinttpswriogs
Accesslogfile:  access_log
Errorog file: ermor_log

Log maintenance: 7 days
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Passed: Your operating system completed the prerequisites check successfully.

Your operating system meets or exceeds the requirements for this product. See
the WebSphere Application Server detailed system requirernents Web pages for
more information about supported operating systems. Go to the product support
Web pages to obtain the latest maintenance packages to apply after installation

ClickNext to continue the installation.

<Back Nexi = Cancel
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<Directory />

Order Deny,Allow

Deny From all
</Directory>

"Mozilla/2" mokeepalive
"JDK/1\.0" force-response-1.0
"Java/1\.0" force-response-1.0
"RealPlayer 4\.0" force-response-1.0
"MSTE 4\.0b2;" nokeepalive

"MSTE 4\.0b2;" force-response-1.0
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E\Surzmn\msaswhkmu o T Lo D parenatolnstall-hat hostnane denicas2 —userna

1112012 1: 4.473 — UNGIOO211: Remote Installation of IBM Installation Manager or WebSphere App
Mication Server to the IBM i nachine starts .o

1112012 12:26:24.473 ~ UNGI0O331: User input connands:

pi112012 - Hostnane: denicas?

pi112012 - usernane: gsecofr

pi112012

pi112012 \Sof tuare\UASBSNIBHiNInstMgr_IBM_I_WAS_8.5.2ip

puoien Connected to denicas2 by con.ibn.tivoli.renoteaccess.AS480Protoc
pi112012 Tranferring Files to denicas2, please wait.
1112012 .40.486 - UNGIOB4AI: Directory listing of /QIBM/intenp. Offerings confi
Tation docunentation  Features License native plugins tools consoleinst  insta
Bt dnecante installe.ini = readne_1.5-3-henl Fepository.confiy Tepository.xn

userinste userinste. ini
p1/11/2012 01:00:40.486 - UNGI0301: Installing IBM Installation Manager, please wait ...

1/11,2012 1:00:49.486 — Inctall command: /QIBM/intemp installe —acceptlicense —accescRights adnin

1112012 01:01:39.769 — Inctalled con.ibn.cic.agent_1.5.2000.20120223 0907 to the /QIBM/ProdData/In
tallationManager/eclipse directory.

1112012 0 19,988 - UNGI0B44)
o Ticense properties

Directory listing of /QIBM/ProdData/InstallationManager: eclip

P1/11/2012 01:01:31.206 ~ UNGIOBHI: Directory listing of /QIBNInstallationfanagers - ibn
2o S 56 L 00l ivseony atiog ot (QUB o esllsg o 1o
finge* Pluginteate ' logs 32 installleistry bundles histaries dapters tonp
ndnsearl Shecallhoglocey a1 incealledixel * insealled-xed  installed-xnl

1/11/2012 01:02:07.458 — UNGIG221: Remote Installation of BN Installation Manager or VebSphere App
Mication Sexver to the IBM i machine ends.
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~ Common Tasks and Wizards
1 Create Web Services Server
1 Create HTTP Server
1 Create Appication Server
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Create HTTP Server

‘The server rootis the base directory for your server. Within this directory, the wizard will reate subdirectories for your logs and
configuration information. Supported fle systems for the server root are root and QOpenSys.

‘Which directory would you like to use as the server root for your new server?
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Note: Ifthe server root directory does not exist, the wizard will create it for you
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1BM WebSphere Application Server 7.

Welcome to the IBM WebSphere Application Server Network Deployment
installation wizard.

“This wizar! installs [EM WebSphere Application Server Network Deployment.

Addfional information can be faund at the Infarmation Centers and Suppor sites
for WehSphere and relaled oroducts homepage.

ClickNext to continue






OEBPS/img/install_nd_example.gif
> imcl install com.ibm.websphere.ND.v85 -repositories /home/ND -installationDir|
ectory /QIBM/Proddata/WebSphere/AppServer/V85/ND -properties was.install.os40|
0.profile.location=/QIBM/userdata/WebSphere/AppServer/V85/ND -sharedResources|
Directory /QIBM/userdata/installationmanager/IMShared -acceptlLicense -showPro

gress
25% 50% 75% 100]

Installed com.ibm.websphere.ND.v85_8.5.0.20120501_1108 to the /QIBM/Proddata/|
WebSphere/AppServer/V¥85/ND directory
$
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> imcl listInstalledPackages -long
/QIBM/ProdData/InstallationManager/eclipse : com.ibm.cic.agent_1.5.3000.20120
531_1954 : IBM® Installation Manager : 1.5.3
/QIBM/ProdData/WebSphere/AppServer/V85/Express : com. ibm.websphere. EXPRESS. v8
5_8.5.0.20120501_1108 : (IBM WebSphere Application Server - Express : 8.5.0.0)
/QIBM/Proddata/WebSphere/AppServer/V85/ND : com. ibm.websphere.ND.v85_8.5.0.20
120501_1108 : (IBM WebSphere Application Server Network Deployment : 8.5.0.0

$
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> ./managesdk -listAvailable -verbose
Available SDKs :
1.6.64

CUSDK10031:
CWSDK10051:

- com.ibm

- com.ibm

- com.ibm
6/6dbit

- com.ibm

- com.ibm

- com.ibm

CUSDK10051:

- com.ibm

- com.ibm

- com.ibm
/84bit

- com.ibm

- com.ibm

- com.ibm

SDK name:
.websphere.
.uebsphere.
.uebsphere.

.websphere.
.websphere.
.websphere.

SDK name:
.uebsphere.
.uebsphere.
.websphere.

.uebsphere.
.uebsphere.
.uebsphere.

sdk
sdk

sdk
sdk
sdk

.version.1.6_64=1.6
.bits.1.6_64=64
sdk.

location. 1.6_64=/Q0penSys/QIBM/ProdData/JavaVM/ jdk62|

.platform.1.6_64=0s400
.architecture.1.6_64=ppc64
.systemlaunchproperties.1.6_64=$(UAS_INSTALL_ROOT}/pr

1.7_64

sdk
sdk
sdk

sdk
sdk
sdk

.platform.1.7_6
.architecture.1.7_64=ppcéd
.systemlaunchproperties.1.7_64=8(UAS_INSTALL_ROOT}/pr

version.1.7_64=1.7
bits.1.7_64=64

.location.1.7_64=/Q0penSys/QIBM/ProdData/JavaVM/ jdk70

=05400

operties/systemlaunch/base/0s400/generic/1.7_64.systemlaunch. properties
- com. ibm.websphere.sdk.nativeLibPath.1.7_64=8{WAS_INSTALL_ROOT}/1ib/native/
05400/ppc_64
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Installation Wizard for the Update Installer

Flease read the following license agreement carefully.

intemational Program License Agreement

Part 1 - General Terms

[BY DOWNLOADING, INSTALLING, COPYING, ACCESSING, OR USING THE
[PROGRAN YOU AGREE TO THE TERMS OF THIS AGREEMENT. IF YOU ARE
IACCEPTING THESE TERMS ON BEHALF OF ANOTHER PERSON OR A
(COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT AND WARRANT THAT
IYOU HAVE FULL AUTHORITY TO BIND THAT PERSON, COMPANY, OR LEGAL
ENTITY TO THESE TERMS. IF YOU DO NOT AGREE TO THESE TERMS,

Read nan-BM terms.

& {accept bl the 16 and the norIEM e

© Ido not acceptthe terms in the license agreement

Print

<Back Next = cancel
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e qsecofr —passuord GEEMEE -vasoid ND —wasrepoloc Zi\Goftuare\uas85\ND —vasinstloc /QIBM/ProdData/h

BSpheresAppServer UGS ND

E:\sonuqrt\uasaswn\)umou Installation_Tool for_IBM_i>iRemotelnstall.bat —hostname denicasi -userna
9330.389 ~ WNNNWNBNBWANANE RIS CIBM i Remote Install Script) v8.5.0.0 WHHAAAS

26/11/2012

T
IBM Corporation 1.6.0

hetp: /o ibn.con/

JavacTH> SE Runtime Enyironment

Jumwi32605r9-28110203 74623

R6/11/2612 89:39:39.465 — UNGIBB2LI: Remote Installation of IBM Installation Manager or WehSphere Apy
lication Server to the IBM i machine starts ...

26/11/2612 ©9:39:30.485 — UNGIBB33I: User input commands:

06/11/2012 89:39:30.405 - hostnane: denicast
06/11/2012 89:39:30.485 - usernane: gsecofr

06/11/2012 89:39:30.485 - passuords s

06/11/2012 89:39:30.405 - wasoid: ND

26 1172012 09+ - wasrepoloc: ZiSof tuareuasBS\ND

06112012 - wasinstloc: /QIBN/ProdData/VebSphere AppSeruer/U8S/ND

e 112002 - UNGIBB241: Connected to denicasi by con.ibm.tivoli.remoteaccess.AS408Protoc

31.280 - UNGIBO251: Transferring files to denicasi, please wait...

optLicense -repositories /QIBM/intemp/ND —installationDirectory /QIBM/Prodbata/lebSphere/AppServer U
S/ND —sharedResourcesDirectory /QIBH/ProdData llebSphere/AppServer/UB5/ND_Shared install com.ibm.webs

6/11/2012 09:57:38.150 - Install conmand: /QIBM/ProdData/InstallationManager/eclipse/tools/incl —ac
here .ND.uBS —properties cic.selector.nl=en
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>

./enableJVM -jvm std32

ADEJOO13I: Enabling the product to use the specified JVM.
ADEJOO14I: Enabling profile default to use the specified JVM.
Dec 23, 2009 11:54:38 PM com. ibm.ws.config.ModelMgr

INFO: WSVRE8O1I

ADEJBO141: Enabling profile wp_profile to use the specified JVM.
ADEJOOO1I: Success: The product will now use the specified JVM.

$






OEBPS/img/installed_sdks.gif
> cd /QIBM/Proddata/WebSphere/AppServer/V85/ND/bin
$
> ./managesdk -listAvailable
CWSDK1003I: Available SDKs
WSDK1005 SDK name: 1.6_6
CWSDK1605I: SDK name: 1.6_32
CWSDK1605I: SDK name: 1.7_64
CWSDK1005 SDK name: 1.7_32
CWSDK1001I: Successfully performed the requested managesdk task
$
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@ wensphere

lcation Servers.
Create HTTP Server

Your server can record activity on your web site using an access log. The access log contains information about requests made to the
senver. This information is useful for analyzing who is sing your web site and how many requests have been made during a specific
period of time.

Do you want your new server to use an access log?

@ves
Ono

Note: An error log is separate from an access log and will be used by your new server regardiess of your decision to use an access log
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iRemoteInstall.bat
~hostname 15 hostname
-username user login name
—password user login passvord
~iminstkit im install kit file path and name | -wasoid vas offering id
-wasrepoloc was_install file location
-appdataloc im agent data_location
-wasinstloc was install location
-wassharedloc vas_shared location
~features feature ID 1,feature ID 2, - - -
-waslangs lang ID 1,lang ID 2, . - -
-properties key=value, key=value, . . -
-log log file path and name
~trace
~help
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Installati

n Wizard for the Update Installer

Installation Wizar for the Upate Installer

Welcome to the Installation Wizard for the IBM Update Installer or WebSphere
Software. Additional infarmatian can be found atthe Information Centers and
‘Support sites for WebSphere and related products home page.

ClickNext to continue.
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> ./managesdk -setCommandDefault -sdkname 1.7_64
CWSDK1021I: The command default SDK name is now set to 1.7_64.
CWSDK1001I: Successfully performed the requested managesdk task.
$
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Installation Directory
1BM WebSphere Application Server Netwark Deplayment, Version 7.0 will be
installed to the specified directory.
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> ./managesdk -enableProfileAll -sdkname 1.7_64 -enableServers
CWSDK1017I: Profile default now enabled to use SDK 1.7_64.
CWSDK1017I: Profile AppSvrOl now enabled to use SDK 1.7_64.
CWSDK1001I: Successfully performed the requested managesdk task.
$






